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Welcome

Roland Waddilove
An all-around expert in all things Mac and iOS, 
this month Roland demonstrates how to 
master Google Backup & Sync and listen to 
local radio stations through the VLC app.

Shaun McGill
This issue, our tech expert has compiled the 
ultimate guide to getting your Mac and iOS 
devices in a fit and healthy state to accommodate 
the imminent release of High Sierra and iOS 11.

George Cairns
Our creative expert helps you fine-tune your 
Photos, iMovie and Final Cut Pro projects this 
month by applying Hollywood-style grading, 
video postcards and creative captions.

Meet the experts

“Take stock of what the update offers 
and balance it against what you need”

 iCreate 177

Whenever a new macOS or iOS update is made 

available, the temptation is to dive in and upgrade your 

system without question, but is this necessarily the right 

course of action? Sometimes a little restraint can be 

useful in order to take stock of what the update offers 

and balance it off against what you need. For example, 

what if you use a particular set of apps for your work 

and these apps aren’t compatible with the new 

updates? And what if, heaven forbid, something goes 

horrendously wrong during the update process and you 

lose important data? This is why, as macOS High Sierra 

and iOS 11 are rolled out, we have provided an essential 

guide to help you get your Mac and iOS devices fighting 

fit to handle the new updates – check it out on page 14.

Also this issue we turn the spotlight on the iPhone. 

We all know how it can make your life easier through its 

various apps and functions, but did you know that it can 

actually help save your life in an emergency? Turn to 

page 48 now to find out how. Enjoy the issue!

Ryan Butt Editor
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#Trending

Samsung is the 
latest tech giant 
to enter the 
home speaker 
race. Following 

in the footsteps of Amazon, 
Google, and of course Apple, 
Samsung’s speaker is already in 
production so we can expect to 
see it sometime next year. Expect 
it to be aggressively priced, 
bundled with some of Samsung’s 
smartphones and feature the 

Bixby virtual assistant software. 
But, even with a non-exploding 
battery, Samsung face an uphill 
battle to make headway in a 
market that they’ve been left 
behind in quite badly. 

You could say the same about 
Apple’s HomePod speaker, but 
its pre-Christmas release date 
looks set to make it the number 
one tech present on everybody’s 
wish list. That’s in no small 
part due to an eye-catching 

Apple’s new iPhone might be grabbing all the headlines, but here are five reasons why 
HomePod could be the best new release of the year

Why we can’t wait  
for HomePod

features that made everybody 
stand up and listen when it 
was announced during Apple’s 
2017 Worldwide Developer 
Conference. To say we’re excited 
about it is an understatement. 

“Apple reinvented portable 
music with iPod and now 
HomePod will reinvent how we 
enjoy music wirelessly throughout 
our homes,” Apple’s senior 
vice president of Worldwide 

Marketing Philip Schiller said 
at the time. “HomePod packs 
powerful speaker technology, Siri 
intelligence and wireless access 
to the entire Apple Music library 
into a beautiful speaker that is 
less than seven inches tall, can 
rock any room with distortion-free 
music and be a helpful assistant 
around your home.” 

why we can’t wait to get our 
hands on HomePod…

HomePod delivers a perfect 
listening experience whether 
placed on a shelf, in a corner 
or in the centre of a room…

8



1: Siri support
You need Apple Music 
membership to make the most 
of HomePod, but Siri, Apple’s 
digital personal assistant, has 
much more up its sleeve than 
the ability to control your music 
collection. Siri can handle a 
range of queries, including 
sending messages, setting 
alarms, offering weather updates, 
making calendar entries, 
performing language translations 
and so much more. Apple has 
built HomePod for the security 
conscious too, ensuring that 
none of your conversations 
around the house are listened in 
on. HomePod isn’t activated until 
it hears the “Hey Siri” command, 
and then all communication is 
encrypted and anonymised to 
protect your privacy.

2: Sound quality
While voice control isn’t anything 
new, having a home speaker that 
actually sounds good is. And this 
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has been HomePod’s key selling 
point. HomePod is packed with 
sophisticated technologies to 
provide the best possible sound 
– and the reports from those who 
had early hands-on access have 
been overwhelmingly positive. 
There’s a custom array of seven 
beamforming tweeters at the 
base of the speaker, each with  

well-balanced and smooth  
sound signature. A four-inch 
Apple-designed woofer sits at the 
top of the casing, which delivers 
deep and clean bass with little to 
no distortion.

3: Apple Music integration
Apple Music gives you access 
to a music library in excess of 
40 million tracks, which in turn 
makes HomePod a real music 
powerhouse. And when you 
combine it with Siri commands 
like “I like this song”, HomePod 
provides deep knowledge of 
personal music preferences and 

At just under seven inches tall, 
HomePod can be placed almost 

anywhere in the home and is 
available in white and space grey.

Use HomePod with Siri from 
across the room to listen to 
Apple Music, control HomeKit 
accessories and more.

tastes and helps users discover 
new music – and it even pushes 
that information to your other 
devices. HomePod can handle 
advanced queries as well. Ask 
“Who’s the drummer in this 
track?” or create a shared Up 
Next list with other users in the 
house and Siri gets to work. 
There are six microphones 
onboard, which means your 
requests will always be heard, 
even with loud music playing. It’s 
ad free too, unlike its rivals.

4: Spatial awareness
As we alluded to earlier, the 
technologies inside the HomePod 
are advanced and innovative. 
Apple’s A8 chip is the brainpower 
behind the audio technologies 
on show, but it’s the automatic 
spatial awareness that really 
raises the eyebrows. Automatic 
room-sensing technology allows 
HomePod to quickly learn its 
position in a room, whether it’s 

in a corner, on a table or in a 
bookshelf, and within seconds 
is perfectly optimised to deliver 
an immersive music listening 
experience wherever it is placed.  

5: HomeKit hub
HomePod naturally comes with 
built-in support for HomeKit-
controlled smart devices, 
which means you can ask Siri 
to perform all manner of tasks 
around your home. For example, 
get Siri to turn the lights on, close 
the blinds or select a scene. And 
the best bit? HomePod works as 
a hub to provide remote access 
via iOS 11’s Home app. 

HomePod will be available for 
$349 in white and space grey in 
December initially in Australia, the 
UK and the US (Australian and 
UK prices haven’t been released 
yet), and you’ll need to have an 
iPhone 5s or later, running iOS 
11. Start saving now because you 
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Things we learned 
this month

High Sierra support for 
virtual machines   Mac

The latest sets of virtualisation 
software for Macs have been 
announced, with both offering 
support for macOS High Sierra 

when it gets released later this autumn. 
VMware announced Fusion 10, which also 
includes support for the latest Touch Bar 
MacBook Pros. That means quick access 
to Outlook, Cortana and the Windows 

Start menu. Fusion 10 can run hundreds of 
operating systems, ranging from the latest 
Windows 10 versions to lesser-known 
Linux distributions. 

Parallels Desktop 13 for Mac has also 
been announced, also with Touch Bar 
support, and a new Picture-in-Picture 
mode that aims to let users monitor their 
virtual machine with ease.

It’s no secret that the Chinese market is a huge growth 
opportunity for Apple, and the Cupertino company has 
strengthened its hand in that market by appointing Isabel 
Ge Mahe as managing director of Greater China. Mahe 

has been promoted to this brand new role after nine years working as 
vice president of Apple’s wireless technologies, having played a major 
role in the emergence of Apple Pay and HomeKit, and Tim Cook 
seems delighted with his appointment. Apple’s CEO says: “(Mahe) 
has dedicated a great deal of her time in recent years to delivering 
innovation for the benefit of Apple customers in China.” 

Apple continues to invest  
in China   Apple

#Trending
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Apple has updated its Safari Extensions webpage with 
a focus on those now available via the Mac App Store. 
The page now includes the ability to install extensions 
with just a single click, and sports a fresh new look with 

nine featured apps at the top ranging from 1Password, to Notifier 
for GitHub, to a translation extension. Below the featured apps 
you’ll find a sort bar to customise the way you look at the available 
extensions. There are only 27 extensions available on the Mac App 
Store currently, so it’s no surprise Apple includes links for developers 
wishing to create their own at the bottom. 

Apple TV market 
share drops 
dramatically

The fourth-generation 
Apple TV is now two years 
old and, judging by a new 
report into the popularity of 
streaming media players, it’s 

starting to show its age. According to market 
research firm Parks Associate, Apple TV has 
slipped to fourth most popular unit behind 
Roku, Amazon’s Fire TV stick and Google 
Chromecast. In the survey of over 10,000 
homes in the US, Apple TV’s share dropped 
some 15 per cent in the three months up to 
March 2017. It must be noted that Apple TV 
is by far the most expensive of the top four, 

which may go some way to explaining why 
it isn’t the most popular. Consumers might 
also be holding out for Apple’s long-awaited 
4K Apple TV version which is rumoured to 
be released very imminently and also feature 
improved Siri functionality and more storage 
as well as 4K/HDR video support. 

“Consumers might 
also be holding out for 
Apple’s long-awaited 4K 
Apple TV version”

New Safari Extensions  
webpage goes live  Safari

Spark gains third-party  
app integration   Mac

One of our favourite third-party Mail clients has made itself even more 
attractive by bringing custom third-party integrations in a new update. 
Spark, a free download from the Mac App Store, now lets you integrate 
with task management apps like Things, Wunderlist, Evernote and Bear. 

Developer Readdle explains the reasoning behind the big update: “Integrations with 
third-party services is another step in creating a product that helps you control your 
inbox while avoiding information overload. The whole idea behind this powerful update 
is to help you focus on work, making it seamless and easy.” Pretty impressive stuff. 
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5
As we all enjoy listening to our favourite tunes on our Macs and iOS 
devices – especially as the Apple Music service puts our ears in touch 
with thousands of great tracks instantly. That is why we have focused 
on sound for this month’s projects to provide three ways to get the 
most out of audio on your favoured device. We show you how to limit 
the volume when listening through headphones, tweak the EQ levels for 
better sound and get audio feedback when adjusting the volume.

MINUTE PROJECTS
TO TRY TODAY

3

1 2

#Trending

We all love listening 
to music on our 
iPhones but this can 

have damaging effects on 
our ears if the volume is set 
too high. Thankfully there 
is a way to limit the volume 
output when headphones 
are plugged in and it can be 
found in the Settings app.

1  Limit your 
volume output

1 Go to 
Settings
From your 
iPhone’s 
Home screen, 
navigate to the 
Settings app 
and then scroll 
down to the 
Music settings. 
Tap on this 
to display all 
options relating 
to Music.

2 Tap on 
Volume
Now scroll 
down to the 
Playback 
section of 
options and 
you will see 
an option for 
‘Volume Limit’, 
which is set to 
‘Off’ – tap on 
this to reveal 
more options.

3 Setting 
the limit
You should 
now see an 
option called 
‘EU Volume 
Limit’. Move 
the slider to the 
‘On’ position 
and you should 
notice that the 
Max Volume 
slider will move 
to a safe limit.

If you don’t have 
the spare cash to 
splash on expensive 

new headphones to make 
your music sound great then 
don’t worry because you 
can adjust the EQ settings 
on your iPad to make your 
existing headphones sound 
artificially better.

2  Adjust your EQ 
volume settings

1 Go to Music Settings
Open the Settings app on your iPad and 
then scroll down the left-hand column of 
categories until you come to the Music 
section – tap on this to open it.

2 Tap on EQ
Tap on ‘EQ’ under the Playback settings 
to view the presets. Depending on what 
you are listening to you can select a 
different preset to improve its quality.

3 Boost the bass
Apple’s own standard headphones can 
sound a bit tinny so beef them up a bit 
by selecting the ‘Bass Booster’, preset 
to improve the all-round sound.

By default, when you 
adjust the volume in 
macOS you don’t get 

any sound feeback to reflect 
the change so that you know 
it is the right level before 
bombarding your ears. There 
is a quick and easy way to 
turn it back on though, just go 
to your System Preferences.

3  Turn on Mac 
sound feedback

1 Open System Preferences
Open up your Mac’s System 
Preferences by selecting it from the 
Dock or by selecting it from the Apple 
menu. Once done, click on ‘Sound’.

2 Click on Sound Effects
Click on the ‘Sound Effects’ tab at the 
top of the window and you should see 
that the ‘Play feedback when volume is 
changed’ option disabled.

3 Enable option
Enable this option and then whenever 
you turn your Mac’s volume slider up or 
down you will hear a simple feedback 
sound chime out to guide you.
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A
pple puts a great deal of effort into 
ensuring that an operating system 
upgrade is as seamless as it can 
possibly be by releasing many 

developer and public betas, but you can never 
be too prepared for such a change. When you 
consider how valuable your data is, which likely 
consists of years of photos and other useful 
information, you really will want to be as careful 
as possible and do everything you can to make 
sure you continue to have access to what you 
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Get your Mac, iPhone and iPad set for 
macOS High Sierra and iOS 11
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In macOS High Sierra you can now edit photos in a third-party app by right-
clicking on an image and selecting the ‘Edit with…’ option.
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Back up your Mac
You have many options open to you when it 
comes to backing up your Mac and securing 
your precious data. There are also various 
approaches that can be taken which involve 

either making full clones of everything or simply 
choosing to back up the most important files. 
The choice is yours, but please make sure you 
have some kind of backup.

 Old, but good
Time Machine is an older Apple 
solution, but it works well and 
with enough disk space available 
it offers adequate peace of mind.

 Third-party solutions
Solutions like Backblaze let  
you pay a monthly fee for an 
offsite backup of your Mac.  
A decent temporary solution 
when upgrading.

 Just the files
If you are already paying for 
iCloud storage, why not copy 
your most important files to 
iCloud Drive for no extra cost?  The box

Dropbox works similarly to 
iCloud Drive, but is very fast 
and extremely reliable. Worth 
considering for very important 
data when upgrading the OS.

1 Open the preferences 
While in Safari, click the ‘Safari’ menu option at 
the top and then click ‘Preferences’ to see what 
can be changed.

2 Get some help 
Click the ‘Privacy’ icon and then the small ‘?’ 
to reveal much more information about how the 
new feature adds to your privacy.

3 Enable the options
Now click both of the options under ‘Website 
tracking’ and Safari will do all of the work for 
you in the background.

Always try to 
back up your 

data to a range 
of different 
mediums. 

Store it

Setting up Intelligent Tracking Prevention in High SierraStep-by-step
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In macOS High Sierra, when you search in Mail the results will be more 
accurate, right down to sender status and how often you replay to them.

1 Open the app 
Go to System Preferences and open Time 
Machine. Click ‘Select Backup Disk’ and 
choose the volume you want to back up to.

2 Excluding data 
Now click ‘Options’ and click the ‘+’ icon to 
exclude folders you do not need to back up. 
Be as thorough as possible here.

3 Access it anywhere 
Finally, make sure you tick the box to access 
Time Machine from the menu bar and to also 
‘Back Up Automatically’.

You will be able to set up Safari 
to automatically default to the 
much cleaner Reader view for any 
website that supports the feature. 
With just a couple of settings 
tweaks you can change the way 
Safari works for the websites you 
enjoy most and make the web a 
nicer place to be. As the feature 
becomes recognised widely, you 
may find that all of your favourite 
sites support it in the future.

Safari 
Reader 
everywhere

A simple setting
In Safari preferences, click 
‘Websites’ and ‘Reader’. 
Enable the ‘other websites’ 
option at the bottom.

A beautiful web
The end result will be articles 
that are easier to read and 
which feel as if they are not 
housed on websites.

Set up Time Machine 
in seconds
You now know that a 
backup of your data is 
very important when 
upgrading the operating 
system and we would 
advise you to consider 
using Time Machine as 
it is built into macOS 
and is a well proven 

solution. You will need 
to have a separate disk 
available to back up to, 
but everything else you 
need should already be 
available to you to get 
the process started and 
to keep your data as 
secure as possible.

“Consider using Time 
Machine as it is built 
into macOS and is a 
well proven solution”
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Extra things to remember

Delete unnecessary files
There is no scientific reason for this, but it 
makes sense to keep your Mac lean and  
to delete files that you do not need before  
you upgrade.

You need power
If you are upgrading a MacBook, you must 
ensure that the battery is sufficiently charged 
before you start. Ideally you should keep it 
attached to power.

So many apps!
The same applies to apps as for files. If you 
have apps installed that you rarely use, there 
is no point in keeping them installed, so delete 
them before you upgrade.  

As you were
Don’t worry about signing out of accounts 
before you upgrade. Leave everything as it 
is because there is no reason that problems 
should occur because of this.

Check your devices
When you upgrade it is possible that wirelessly 
connected devices may lose their connections. 
Make sure you know what should be 
connected by taking a preemptive screenshot.

Your vital apps
If you have any concerns that your most vital 
apps will no longer work, ask the developer for 
compatibility confirmation of each app before 
you upgrade.

Only upgrade a  
well-maintained Mac
Before you upgrade to any 
new version of macOS you 
should make sure that you 
have taken care of the things 
you may have missed in the 
past. Make sure your apps are 
updated to the latest versions 
and that you have enough 
memory available. 

Also, follow our simple  
tips to clear the clutter and 
you will be able to ensure 
a change of OS that goes 
smoothly and which should 
greatly lessen the chances 
of any failures occurring. A 
healthy Mac is a much better  
upgrade candidate.

“Make sure your apps are 
updated and that you 
have enough memory”

If your Mac is 
running Sierra, it 
will definitely be 
compatible with 

High Sierra.

Get HighBEFORE
UPDATING



 An easy menu
Click the menu icon to access 
quick settings for Backblaze. 
This will act as the main interface 
for the continual backup.

 Is it done?
At any time you can easily 
check the state of your backup 
progress. It will almost always 
say that it is up to date.

 A long wait
Don’t panic if you find that the 
initial backup takes a long time 
because future backups are 
managed incrementally and will 
be much faster.

 Extra settings 
In the Settings menu you can 
choose the schedule of the 
backup and make all sorts of 
other changes when required.

The simple complexity of Backblaze
For a low monthly cost Backblaze will ensure that your 
data is safe no matter what happens. The fact that it is 
offsite means that even if something terrible happens 

to your house you will have a backup and it is perfect 
peace of mind for that moment when you choose to 
upgrade to High Sierra.

Futuristic file system 
The new files system used in High Sierra acts 
like the future and can do things that you would 
not have thought possible.

Photos and videos 
Photos and videos will take up less space and 
will be far more versatile to manage and share 
than previously.

The distant future 
High Sierra will be crucial if you want to take 
advantage of the virtual reality future Apple is 
promising. The future just got closer.

In the macOS High Sierra Notes app, when you search for a particular word 
you will now see matches highlighted as in other apps.

Why upgrade?
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Just because your Apple device is 
iOS 11-compatible does not mean 
that you should not do some extra 
checks before you upgrade to the 
latest and greatest. There are many 
practical considerations that should 
be thought about before you make 
the move because it is not always 
easy to downgrade to the previous 
operating system version and it 
greatly enhances the likelihood of 
you losing important data. For the 
vast majority, however, the upgrade 
should feel completely seamless.

Extra 
small 
checks

Storage 
requirements
Go to Settings>General> 
Storage & iCloud Usage to 
ensure that you have ample 
storage space available to 
cope with the upgrade.

Up to date?
Always make sure that you 
have upgraded to the latest 
version of the previous 
operating system revision. Try 
to avoid skipping updates.

 Bars, not dots
The familiar signal dots have  
now been replaced by more 
logical bars which make the 
process of checking the strength 
much easier.

 The swipe down
When you swipe down from 
the top in iOS 11, you will 
interact with notifications slightly 
differently. They are even more 
natural now.

 Discover more
Almost every other part of iOS 
11 is visually identical to iOS 10. 
The major changes are hidden 
beneath the surface.

 A new panel
The control panel has been 
heavily upgraded and is now 
completely customisable. It is a 
major highlight of iOS 11.

Apple, as usual, is generous when it comes 
to new OS upgrades working on older 
devices, but it is not always as simple as you 
may think. You will need to consider if your 
iPhone or iPad is performing well at this time 

and if you believe that the new features will be 
worth the potential slowdown in performance. 
We would suggest being extra careful if you 
are considering upgrading an iPhone 5s or 
iPad mini 2 to iOS 11.

Expect some changes in iOS 11
As a general rule, the changes in iOS 11 are very subtle 
with some standout visual tweaks which will become 
obvious as soon as you upgrade. You should be working 

with iOS 11 perfectly naturally just as you have been in 
iOS 10, but it is useful to know what to expect when you 
make the jump.

Sadly, if you still 
use an iPhone 
5C then you 

won’t be able to 
install iOS 11.

No 5C!

iOS 11-compatible devices
Not all iPhones and iPads can cope with iOS 11
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Upgrade all of 
your devices
There are many changes in 
iOS 11 and High Sierra that 
can be used over all of your 
Apple devices and so we would 
advise you to upgrade them all 
as closely together as you can. 
With iCloud needing to manage 
notes, reminders and so much 

other data independent of 
your devices, we feel that it 
makes sense to try to upgrade 
everything at the same time just 
to be on the safe side. Problems 
are extremely unlikely in this 
area, but it can’t hurt to make 
the jump wholeheartedly.

Failed backup solutionsStep-by-step

3 Keep some data
You will be asked if you want to keep a copyy 
of your contacts and other important data. WWWWee 
would suggest that you enable all options.

4 Reset settings
As a last resort, try resetting network settingsss 
by going to Settings>General>Reset. You will
need to restore various options after.

1 A failed backup
If you see a message saying that the backupp 
could not be completed, try again just in casseee it 
was caused by a temporary blip.

5 Be patient
Notes and other iCloud data will take time too 
restore, but it is worth your time to have a fuulllyy
working backup feature again.

2 Try signing out
Go to Settings and tap your name at the topp.
Now scroll down to the very bottom of the 
screen and tap ‘Sign Out’.

As we have stated, it is vital that your data isss
backed up fully, but from time to time you mmaaayy 
run into problems with iCloud Backup. It is nnoot
always clear what causes backup problemss 
to occur, but there are some tried and testeddd
solutions that will help you to ensure that yoouuurr
data is safe before you upgrade.

Resolve 
iCloud 
problems

“If you have problems witthhhh 
iCloud Backup these aree 
tried and tested solutionssss””

In macOS High Sierra you can now double-tap the Touch bar volume button 
to mute and swipe to adjust the volume and brightness on your new Mac.
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Update Now!

 iPad benefits
On the iPad, you now have the 
ability to swipe away apps that 
you want to close or tap to 
open them.

 Greater efficiency
When music is playing, you can 
jump through tracks or pause the 
music without ever opening the 
Music app. It’s very efficient.

 Your controls
We are all different which is 
why Apple now lets you place 
the Control Centre icons in 
almost any position you like.

 Swiping the controls
In some controls, such as 
brightness and volume, you can 
now swipe them to change the 
actual settings in play.

Try out your new keyboard

1 Flick down 
An iPad on iOS 11 can now benefit from 
flicking down on certain keys to insert numbers 
and punctuation into your text..

2 Explore the settings 
Check the keyboard settings to see what is 
now possible on an iPad and iPhone in iOS 11. 
You may be surprised.

3 Other keyboard tricks 
In Notes, for example, you can now add a 
table or scan documents by using new keys 
placed in the iOS 11 keyboard.

The new iOS 11 Control Centre
You may not realise it, but it is likely that you access the 
iOS Control Centre by swiping up from the bottom of 
the screen multiple times a day. Well, Apple has made 

some big changes to the way it works in iOS 11 and it 
is without doubt reason alone to consider upgrading 
because its flexibility has been greatly increased.
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Backing up 
your data
There are certain genres of data that 
transcend a simple backup and which may 
deserve a separate solution that means they 
are held in multiple places. These can include 
financial transactions, important contacts and 
information that is of a highly personal nature. 
In these cases you should ideally be using 
apps that offer multiple backup methods and 
ones that have been tested to ensure that 
they will keep your data safe in the long run 
and in standardised formats.

1 Multiple backups
Check all of the options for backing up and 
exporting your data and back it up in two 
formats before you upgrade iOS.

2 Extra copies
If you can, send a copy of the file to yourself  
in a format that can be recognised in other 
apps as well.

1 Find the apps
Go to Settings>General>About and tap 
‘Applications’. In the list of incompatible apppsss 
tap one to see its App Store listing.

2 Scroll down
Scroll down to the bottom and you should seeeee
a ‘Developer Website’ option. Tap it to be takkkeenn
there in Safari.

3 Contact the developer
You can contact the developer to ask if they 
intend to update the app. If not, you will needdd
to find an alternative.

Checking the compatibility of old appsStep-by-step

Over time you have likely collected many apps that youu ddoo
not use and some which are essential. In iOS 11, howeevveerr,,
some apps will no longer work so find the culprits and dddoo

what you can to rectify the situation. We’ll show you wwhhhaat 
you need to do to keep as many apps running as posssiblee 
and there should always be a solution for each app. 

In macOS High Sierra, those in a family sharing group can now all share the 
same plan, which should save you some money each month.
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Apply Hollywood grading effects
Most photographs featured in books and magazines have 
their colours and tones professionally adjusted (or graded) to 
overcome problems with incorrect colour balance or under-
exposure. Grading can also be used in a more creative way to 
change the mood of a shot. For example, a crime novel’s cover 
shot may have its tones tweaked to darken the shadows and 
add a sense of mystery. Colour hues can be shifted to create 
a more stylised colour palette, with a cold wash of moody blue 
in the midtones. Apple’s Photos app has a collection of preset 
filters that alter colour and tone in a click. We’ll use a preset as 
a springboard for our grading walkthrough and then manually 
adjust colour and tone to make a striking film-noir femme fatale.

Use filters and manual adjustment tools to give your photographs a movie makeover

Creatively grade colour and toneStep-by-step

Time needed

10

Difficulty

1 Import image 
Choose File>Import. Browse to our supplied 
start file – grading_before.jpg. Click ‘Review for 
Import’. Double-click on the imported shot’s 
thumbnail. Click the Edit photo icon.

2 Apply a filter
Click on the Filters icon to access a series of 
one-click filter effects. Click on the ‘Process’ 
thumbnail to add a wash of cool blues to the 
shadows and turn lighter skin tones magenta.

3 Access levels tools
Click on ‘Adjust’ to access manual colour and 
tone tweaking tools. Click on ‘Add label’ and 
choose ‘Levels’. This will enable us to manually 
crush shadows and brighten highlights.

4 Increase contrast 
In the histogram drag the shadow control right 
to darken shadows. Drag the highlight control 
left to brighten highlights. This creates an 
analogue-style bleach bypass look. 

5 Before and after
Drag the midtone control left to lighten the 
midtones and reveal more of the face. Press the 
‘M’ key to toggle between the edited version of 
the photo and the unprocessed original.  

6 Cool things down 
In the Color panel drop Cast to -0.28. This 
accentuates the blues of the eyes and metal. 
Drop Saturation to -0.27 for a subtler wash of 
colour that suits our film-noir style subject.

Photos

Before After

Download available
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To create film-noir style lighting shoot your subject using a single remotely 
triggered flash gun by their side, for dramatic shadows and highlights. 

Adjust colours 
and tones
Apply Hollywood grading 
techniques to your portraits

Analogue processing 
techniques
Traditionally film negatives 
were adjusted using darkroom 
chemicals. If you processed 
slides in chemicals designed for 
prints this would create shifts in 
hue. The Photos app’s Process 
filter mimics this analogue 
technique. The analogue Bleach 
Bypass film development 
process creates crushed blacks 
and blown out highlights. We 
mimicked this classic analogue 
look using the Levels command.

 Knowledge base

 Levels
A shot’s tones consist of shadows, midtones and 
highlights. These tones are measured in levels with 
0 for black shadows and 255 for white highlights. 
These control points enable you to selectively 
remap original levels to lighter or darker values. 

 Add extra effects
The ‘Add’ button enables you to access extra 
photo fixing tools such as the Vignette command 
and the powerful Levels adjustment tools. Just 
tick a panel’s label to summon (or remove) it. 

 Colour hue 
You can adjust properties such as 
colour Cast to add a colder and 
moodier cyan wash to the shadows, 
while the subject’s skin tones take on 
a stylised magenta hue courtesy of 
the Process filter.

 Vignetted 
edges
By using the sliders in 
the Vignette panel you 
can cause the shadows 
to close in around your 
subject and create a 
more dramatic and 
mysterious looking film-
noir style portrait.  

7 Add a vignette
To make the shadows close in around our 
subject click on ‘Add’ and choose ‘Vignette’. 
Drag the Vignette Strength slider to 1.00 to 
darken the edges. Drag Radius to 0.75

8 Copy adjustments
After perfecting a dramatic look you can quickly 
apply it to other shots. Choose Image>Copy 
Adjustments. Go to another shot and choose 
Image>Paste Adjustments.

9 Export the image
Go to File>Export>Export 1 Photo. To share 
online set Photo Kind to JPEG and keep Quality 
to Maximum. To share on electronic devices set 
Color Profile to sRGB. Use Adobe RGB for print.



Create a video postcard
A traditional way to show off the highlights of a holiday was to 
send a postcard featuring photos of local landmarks, with a few 
lines of text scribbled on the back to describe your adventures 
abroad. Thanks to iMovie’s range of powerful post-production 
tools, titles and templates you can creatively combine video 
clips of your holiday activities into a short and snappy ‘video 
postcard’ that will be easy to upload and share on social media 
sites. We’ll show you how to enhance your postcard using 
the Mac’s built-in FaceTime HD camera to record a holiday 
greeting. You’ll also discover how to crop, resize and position 
this video greeting to create a postage stamp-style insert.

Show off a favourite holiday location on social media

Compiling your postcard
Add extra assets and FaceTime sourced footage

 Knowledge base

Sound advice
Drag a music clip into the 
timeline from the Jingles folder. 
Alt-click on the music clip’s 
volume control bar just before 
the voice greeting begins to 
add a control point. Alt-click to 
add a second adjacent control 
point. Drag the second point 
downwards to dip the music’s 
volume so that it doesn’t drown 
out the voice.

 Travel transitions 
Once you’ve chosen a new Theme (such 
as Travel), you’ll find extra graphics in 
the Transitions and Titles browsers. You 
can explore these new assets and drag 
them to the timeline to enhance your 
video postcard.

 Picture in Picture
The Video Overlay panel 
gives you access to the 
Picture in Picture tool. 
This enables you to scale 
down layered footage and 
reposition it to give your 
inserted talking head footage 
a postage stamp-style look.

 Crop it
To zoom in on our FaceTime 
camera’s postage stamp-style 
insert we used the Crop to Fill 
Style. You’ll find that in the 
Cropping tools collection by 
clicking this icon.

 Themes
To access extra postcard style 
titles and transitions for your 
video postcard, click on Settings 
and choose the Travel theme. 
This will automatically add 
animated travel themed titles  
and transitions to your edited 
timeline footage.
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Time needed

15

Difficulty

iMovie

Download available
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For a tidier video insert from your FaceTime HD camera, place blue card 
behind you. Hide the edges of the card when you use the Crop to Fill Style.

How to make a video postcardStep-by-step

1 Import assets
Go to the Projects panel. Click ‘Create New’ 
and choose ‘Movie’. Go to File<New Event. 
Label the Event ‘Holiday Postcard’. Click 
‘Import Media’. Browse to supplied clips.

2 Add a wide shot
Drag the ‘Mountain’ clip into the timeline. This 
wide shot establishes our holiday location. Trim 
the clip so that it runs for five seconds. A short, 
snappy postcard will hold the viewer’s attention. 

3 Add all assets 
Drag the rest of the shots into the timeline to 
show holiday staples such as the view from a 
hotel room and a scenic sunrise. Trim the clips 
to give them all a five-second duration.

4 Add a theme
By default our project has no theme. Click on 
Settings at the top-right of the timeline. Click 
the Theme button. In the Themes browser 
window, choose ‘Travel’ and click ‘Change’.

5 Add a caption 
The Travel theme automatically adds animated 
postcard-style titles and transitions to the 
timeline. Double-click on the opening title to 
add a custom caption such as time and place.

6 Add a title
Click on the Titles browser label (or press 
Cmd+3). Drag the Middle Title onto the third 
clip. Change the default text to something like 
‘Room with a view’. Click the tick.

7 Record a greeting
Choose File>Import Media. Click FaceTime 
HD Camera. Set the Import to dropdown to 
‘Holiday Postcard event’. Click Record and 
describe your holiday. Click Record to stop.

8 Crop the clip 
Drag your greeting clip onto the timeline. Click 
the Cropping icon above the viewer. Click ‘Crop 
to Fill’. Drag the crop handles to tighten the 
crop around the face. Click the tick.

9 Create a stamp
Click the Video Overlay icon above the viewer 
and choose ‘Picture in Picture’. Drag the 
control handles to re-size and reposition the 
cropped clip into a postcard stamp’s location.



Get creative with your captions 
Titles provide useful ways of introducing a location in a 
documentary or the name of an interviewee. Final Cut Pro X’s 
Titles browser is packed full of presets that animate a range of 
text styles and fonts in creative ways. You can make text drift, 
fade or zoom into place. The downside of using presets is that 
they can make your videos look similar to those of other Final 
Cut Pro users. You may also struggle to find a preset that suits 
your subject. In this walkthrough we’ll combine and modify a 
couple of preset titles to create an animated vintage typewriter 
caption that suits our historical subject matter. You’ll learn how 
to modify a range of preset title properties along the way…

Customise captions to create unique ways to introduce people and places

Create custom captions
Combine and modify titles to enhance your productions

 Knowledge base

Editable attributes
Different titles have editable 
attributes that you can tweak 
to create a unique custom look. 
After adding a title to the timeline 
click on the Title Inspector icon 
to discover which properties you 
can adjust. For example, the 
Splash – Ink Splats title enables 
you to adjust the colour of  
the ink.

 Wipe transitions
Wipe transitions enable the parallel 
elements that make up our title to 
disappear at the same time. This helps 
us synchronise the visibility of multiple 
title tracks.

 Titles browser 
This browser is packed 
full of preset titles 
that boast a range of 
different looks and 
animated moves. In  
our walkthrough  
we’ve combined the 
Paper and Typewriter 
titles to create a  
retro-style caption.

 Text Inspector 
After selecting a title bar in the 
Timeline you can use the Text 
Inspector to modify a wide 
range of text properties such as 
size, font and colour. This helps 
differentiate your title from the 
original preset look.

 Audio effects
An animated caption can be 
augmented using a suitable 
sound effect or audio texture 
from the Audio browser’s Sound 
Effects library. Here we’ve added 
the clacks of a vintage typewriter 
to enhance our animated title.
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Final Cut Pro X
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To balance your typewriter text in the middle of the screen look out for the 
vertical yellow bar that appears when the text is dead centre.

Combine and customise preset titlesStep-by-step

1 Import clips
Choose File>New Event. Tick ‘Create New 
Project’. Set Frame Rate to 30p. Choose 
File>Import Media. Browse to our Normandy.
mov start file. Click ‘Import Selected’.

2 Add Paper title 
Drag the movie into the timeline. Click on the 
Titles browser icon. Drag the Paper title onto 
the timeline. Trim the title to start at 1:00 and 
end at 08:00. In Text Inspector untick ‘Face’.

3 Add a wipe
By default the Paper title fades in and out. Go 
to the Transitions browser. Drag ‘Wipe’ onto 
the purple Paper title bar to make it wipe in and 
then out (instead of fading).

4 Add typewriter text
Drag the Typewriter title onto the timeline. Trim 
it to run parallel with the Paper layer. In the Text 
Inspector type NORMANDY, 6 JUNE, 1944. Set 
Font to Courier Std and Bold. Set Size to 110. 

5 Change text colour
Select NORMANDY. In the Face attribute click 
‘Show’. Click the ‘Color’ dropdown icon and 
choose ‘Red’. Select the rest of the text and 
turn it black to mimic vintage typewriter ink.

6 Reposition the text 
In the viewer, drag the caption’s control handle 
downwards to place the text over the paper. 
Drag the Wipe transition onto the Typewriter 
layer. Delete the wipe in but leave the wipe out.

7 Add sound effect
Go to the Audio browser. Click on ‘Sound 
Effects’. Type ‘Typewriter’ into the search field. 
Drag Typewriter Manual onto the timeline to 
enhance the typewriter style animation.

8 Get the timing right
Trim the Typewriter sound effect so that it starts 
at the same time as the animated text. Position 
the sound effect bar so that the clunk sound 
ends with the caption’s closing wipe.

9 Finishing touch 
Click on the sound effect and press Cmd+B to 
split it where the text stops typing. Split it again 
before the closing clunk. Finally, delete the 
typing sounds between the two cuts.
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Using the Transform Pad
It took US audiences time to identify with modern Dance music. 
When the penny finally dropped, they insisted on re-christening 
their House music as EDM, Electronic Dance Music. Well for 
GarageBand it’s a case of better late to the party than never, 
with modern versions placing the genre centre stage. On iOS 
this is especially true with features such as Live Loops and the 
introduction of new ways to manipulate Alchemy synths. This 
includes the Transform Pad, which has leapt to the macOS 
version to sit alongside the normal Smart Controls, adding a 
grid-like panel for applying ‘snapshot’ effects. Here we look at 
how Transform Pad is used to process over 100 synth patches.

Learn how to use the new panel to add EDM-style effects to Alchemy-based synthesizers

Control synths with Transform PadStep-by-step

GarageBand

Time needed

8-16

Difficulty

1 Open Library
With a project open, we first need an Alchemy 
synth patch. With a software instrument track 
selected, toggle the Library panel open via 
View>Show Library or with the ‘Y’ key.

2 Pick a patch 
Choose the Synthesizer category and then 
EDM Bass. From here, select the ‘Pumping 
Synth Waves’ patch, applying it to the MIDI 
region within a selected track.

3 Transform Pad 
This patch uses the Transform Pad, placed 
within the Smart Controls panel (B). It is a live 
performance control, so loop cycle your track 
audio and press Play (spacebar).

4 Single snapshot 
The pad features eight ‘snapshots’ that are 
labelled to articulate available sounds. A single 
snapshot can be selected by simply clicking 
each, moving the blue framing box.  

5 Move to morph
The framing box can also be dragged and 
dropped between two and four snapshots to 
apply multiple live effects. Drag the box across 
the pad to morph between selected snapshots.

6 Custom effects 
Each pad has two unique dials situated to the 
right. These permit custom effect parameter 
tweaks, adopting any changes to each at the 
current framing box position on the pad. 
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If your Mac or MacBook features the Touch Bar control, it can be used to 
more quickly select and morph between Transform Pad snapshots.

Pad pointers
Delve into a synthesizer patch to pick out the Transform Pad and other core components   

 Additional controls 
Two extra control knobs appear 
to the right, again variable 
depending on the selected  
synth. They will move and adjust 
with snapshot selection and  
if changed, adopt the new 
custom setting at the framing 
box’s position.

 Library patches 
There are 82 patches within 
the Synthesizer category 
and a further 24 within 
Arpeggiator that feature the 
Transform Pad. These are 
applied to a track from the 
Library panel, toggled open 
via the ‘Y’ key.  

 Transform Pad 
The Transform Pad tab 
appears within the Smart 
Controls panel, toggled open 
with the ‘B’ key. Consisting 
of eight ‘snapshot’ pads, 
each holds a unique array 
of sound effects labelled 
individually according to the 
selected synth.

 Snapshots and 
framing box 
Snapshots are selected, 
activated and applied to the 
track by dragging the light 
translucent blue framing box 
over the Transform Pad. Cover 
more than one and multiple 
snapshots are applied, changing 
dynamically as you drag.  

Only selected Synthesizer and Arpeggiator patches 
feature the Transform Pad, totalling over 100 within 
the Bass, Bell, EDM Bass, Lead, Pad and more sub-
genres. Those Synthesizer patches feature the Alchemy 
technology, utilising a special plug-in that can be seen 
within the Inspector pane within Smart Controls. This 
Alchemy plug-in cannot be turned on/off as such, but 
it’s worth noting and remembering that additional Audio 
FX plug-ins can still be added. 

1 Alchemy-equipped 
Patches that boast a Transform Pad are Alchemy 
synths, using a special plug-in. View this inside 
the Smart Controls panel, within the Inspector 
when the Track button is selected. You should see 
a blue Alchemy button in the Plug-ins area.

2 Adding on FX 
Also within this Plug-ins area, you can go on to 
add further Audio FX plug-ins in the little box 
below. Click inside and use the pop-up selection 
menus to add any desired effects into each of the 
four available slots. 

Hidden Alchemy 

 Knowledge base
Blending snapshots
It’s worth remembering that the 
Transform Pad is an additional controller 
for applying live, non-destructive synth 
effects. Preset sounds are applied more 
fluidly by dragging the framing box 
across the eight snapshots. You achieve 
new blends between those sounds by 
covering more than just one, using a 
percentage of the selected snapshots 
to apply diverse effect combinations to 
the patch.

“The Alchemy plug-in cannot 
be turned off…”
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Using the Step Input Keyboard
Without doubt, the easiest way to program musical notes into 
Logic is via an external MIDI keyboard. But what happens if 
inspiration strikes when you don’t have a keyboard available, or 
if you need to enter a rapid sequence of notes or some sheet 
music that’s too difficult for you to play? This is where Logic’s 
Step Input Keyboard comes in handy. Its old-school note entry 
method makes it a winner when recreating retro, 80s-style 
arpeggios and keyboard parts. Not only that, using the Step 
Input Keyboard also happens to be the quickest way to create 
a new MIDI region on a track. Intrigued? Follow the steps below 
to find out more – you can access all the required files to follow 
along with this tutorial on FileSilo.

Step up and check out one of Logic’s most overlooked features 

Programming with the Step Input KeyboardStep-by-step

Time needed

20

Difficulty

1 Set up
Begin by creating a new empty Logic project 
at 120bpm. Create a software instrument track 
and insert an instance of the Alchemy synth, 
leaving the default preset sound loaded.

2 Open a window
Now you need to call up the Step Input 
Keyboard by selecting the ‘Show Step Input 
Keyboard’ option from the lower section of  
the Window menu.

3 Length and loudness
Notes are inserted at the current playhead 
position, so with the playhead parked at 1 1 1 
1, select the 16th-note value button – as shown 
– and the mf velocity setting.

4 Insert note
Inserting our first note will simultaneously create 
a new MIDI region. To achieve this, click on 
the D1 note on the virtual keyboard to insert a 
16th-note D1 on the first beat of the bar.

5 Move on
Double-click the region to open the piano roll 
editor. After each note is inserted, the playhead 
automatically moves on to the end position of 
the most recent note. It’s now at 1 1 2 1.

6 Sequence start
Step Input mode excels at inputting rapid, 
tricky-to-play runs of notes. With the 16th-note 
length still selected, click E1, F1, G1, D2, C2, 
A1, F1 and D1 to get the above sequence.

Logic Pro X

Download available
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The Step Input Keyboard is only available when ‘Show Advanced Tools’ is 
selected. Go to Logic Pro X>Preferences>Advanced Tools and tick the box.

Step in time
Program tricky sequences with Logic’s Step Input Keyboard

Custom key commands
To speed things up, under Logic Pro X> 
Key Commands>Edit>Step Input 
Keyboard, you’ll find a folder of user-
definable keyboard shortcuts for the 
Step Input Keyboard. None of these are 
pre-assigned by default, but you can 
set keystrokes for entering note pitches, 
moving back or forwards by a step, 
inserting a rest at the current note value, 
and many other useful commands.

 Knowledge base

 Velocity buttons
Labelled by the traditional volume 
indicators ppp, pp, p, mp, mf, f, ff, 
and fff, these buttons correspond 
to MIDI velocity values 16, 32, 
48, 64, 80, 96, 112, and 127, 
respectively. Notes are entered at 
the currently selected value.

 It’s triplets!
To enter a triplet group, click the 
button marked with a ‘3’. The next 
three notes you enter will be grouped 
together as triplets. So if an eighth-
note is selected, an eighth-note 
triplet will be created.

 Dotted
When enabled, this 
button enters a dotted 
note – ie a note that’s 
one-and-a-half times 
the currently selected 
note length value.

7 Take a rest
Now we want to leave a gap to the next note 
on beat 1 3 3 1. We can do this by moving the 
playhead manually to this location, then just 
clicking a D1 note on the keyboard to insert it.

8 Chord blimey
Let’s insert a chord next. Move the playhead to 
1 4 1 1 and click the 8th-note and the chord 
buttons. The playhead will now stay put until 
we click the chord button again.

9 Stack up
This allows us to stack the notes A2, D3 and 
F3 to make a D minor chord. Once all of the 
notes are in the chord, click the chord button 
again to resume single-note entry mode.

 Extender
Click this button to 
extend the length 
of the last note 
you entered by the 
currently selected note 
length value.
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Create secure notes in Keychain
We live in a world where we’re expected to handle lots of 
data including passwords, account details and payment card 
numbers. We’re then asked to use different passwords for 
different services to protect ourselves from hackers, all of which 
pushes our memory capacity to its limits. It’s little wonder that 
some people write their passwords down but doing so can 
open you up to all sorts of trouble. This is where the Mac’s 
Keychain Access comes in. It has a Secure Notes feature that 
lets you lock confidential information behind a password. And 
since it is works in an app that few people would think to look 
in, it should mean your details are very well protected.

Ensure private information is hidden from view by locking it away using Keychain Access

Secure private informationStep-by-step

Keychain Access

Download available

Time needed

10

Difficulty

1 Open Keychain Access
Your secure notes will be locked and contained 
in a built-in app called Keychain Access. This 
is in the Utilities folder which you can locate by 
going to Finder>Go>Utilities.

2 Choose a keychain
Double-click Keychain Access and select a 
keychain from the sidebar. Apple advises using 
‘login’ if you’re unsure. Your subsequent note 
will be protected by your login password.

3 New Secure Note
Now, either click File and select ‘New Secure 
Note Item’ from the menu or click ‘Secure 
Notes’ in the sidebar and click the ‘+’ button at 
the bottom of the Keychain Access window.

4 Create a label
The Note creation box will appear. Give your 
note a name by typing it into the first field. For 
added security you may want to create a label 
that only you can later identify.

5 Type your note
Now type the private, sensitive information in 
the second field. Anything that you place here 
will be locked and hidden from unauthorised 
eyes. Click ‘Add’ when you’re done.

6 Check the note
Close Keychain Access and re-open it. You will 
be able to see your note listed whenever you 
click ‘Secure Notes’ (or ‘All Items’). The content 
will be locked away until you need it.
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If you wish to remove a secure note from your Mac, simply right-click the 
unwanted item and select ‘Delete’ from the dropdown menu.

Control access to your notes
You can also create unsecured notes in Keychain Access if you wish

 Click your note
This window will appear 
whenever you click a note in 
Keychain Access. If you click 
‘Show Note’ under the Attributes 
tab, you’ll be asked for your 
password to view it.

 Allow all 
application access
By selecting ‘Allow All 
Applications to Access This 
Item’, you can allow for 
unrestricted access to the 
item that you have created. 
You won’t be asked for a 
password in order to access 
the item in the future.

 Save changes
To lock down the way your 
note is accessed, you need 
to click ‘Save Changes’. 
You’ll then be asked to enter 
your password to confirm  
the alteration.

 Access Control
If you want to control how your 
note is accessed, make sure 
you click ‘Access Control’ in this 
window. By default, ‘Confirm 
Before Allowing Access’ will  
be selected.

 Knowledge base

Create a new Keychain
If you use your login password 
to secure your notes, you 
run the risk that anyone who 
knows your password will be 
able to access them. For better 
security, you may want to create 
a new Keychain and store 
your notes within that instead. 
Open Keychain Access, click 
File>New Keychain and create 
a password. Then select this 
keychain option in step two of 
our tutorial.

The whole idea of securing your notes is to ensure that 
they are kept away from prying eyes. But it’s likely that 
you will want to access them yourself at some point in 
the future. When it comes to that time, all you need to do 
is open Keychain Access. Select ‘Secure Notes’ from the 
sidebar and you will see a list of all of the notes that you 
have locked away. Then follow these steps… 1 Select a note

Click on the note that you would like to open. 
The note will appear on the screen but only its 
name will show in the window. In order to view 
the sensitive part of the note, you will need to tick 
‘Show Note’.

2 Enter your password
Keychain Access will ask for your password. 
What you enter depends on how the note was 
secured. If you have selected to use the login 
keychain, for instance, you’ll be expected to enter 
your login password. Your note will then show.

How to view your 
secure notes

“Select ‘Secure Notes’ and 
you will see a list of all the 
notes you’ve locked away”
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Add a calendar to the menu bar
Apple Calendar is fine for storing your appointments/events, 
and for reminding you when they are due, but if you have a 
MacBook, particularly one of the smaller screen models, it 
takes up a lot of space on the desktop. So, instead of opening 
Calendar, use Itsycal. This lightweight app runs in the menu bar 
and it shows one or two-month calendars, and your upcoming 
appointments and events for the next week or two. Instead of 
loading Calendar, you can create appointments from the menu 
bar. It’s quick and easy to use. Itsycal is free from mowglii.
com/itsycal and it is not a separate calendar app – it is just an 
extension for Apple’s Calendar app.

Make the Calendar app easier to access by adding a menu bar icon and menu using Itsycal

Itsycal

Download available

Time needed

10

Difficulty

View calendars from the menuStep-by-step

1 Run Itsycal 
When Itsycal is run, it adds a small icon to the 
menu bar that shows the day of the month. 
Click it to view this month’s calendar and see 
upcoming events listed below.

2 Add an event
Click the ‘+’ icon or better still, double-click a 
day in the calendar to create an appointment or 
event. Add a name and location, and click the 
date/time to set them.

3 Set event alerts
Creating an event or appointment in Itsycal is 
very similar to the Calendar app. Choose from 
several repeat options for recurring events, and 
choose when to be reminded.

4 Pick a calendar
The Calendar app lets you create different 
calendars and these could be for home, work, 
personal and so on. Select the calendar you 
want to assign the event to from the list.

5 Show the events
After adding several events to your calendars, 
they appear as a list in the lower half of Itsycal. 
By default it shows events for the next seven 
days and this is very useful.

6 Show two months 
Below the calendar is a short line. Drag it down 
to show two months at a time. Click a day in 
the calendar to see a list of events for that day 
and the next seven days.
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Itsycal works with the calendars that are set up in the Calendar app and is 
like an alternative way of accessing it.

The Itsycal interface
See how Itsycal relates to Calendar

 Knowledge base
How to install Itsycal
Itsycal is not in the Mac App 
Store and because of this open 
System Preferences and click 
Security & Privacy. Select App 
Store and identified developers. 
Download Itsycal from mowglii.
com/itsycal, double-click the 
zip to extract it and drag the app 
to the Applications folder. The 
first time you run it, Ctrl+click it 
and select ‘Open’.

 Customise the view
Using the Appearance tab in 
Preferences, the work week starts on 
Monday and Saturday and Sunday 
are highlighted in red. A dot below  
a day means that it contains events 
or appointments.

 Check 
Calendar
The Calendar app does 
not need to be running, 
but if it is loaded, you 
can see that events 
created in Itsycal appear 
in Calendar and those 
created in Calendar 
appear in Itsycal.

 Itsycal appointments
If an event has a specific time and 
location, they appear under the item. 
All day events do not show a time. 
To delete an event, move the mouse 
over it and click the ‘X’ icon.

 Toolbar icons
The ‘+’ icon in the toolbar is for 
adding appointments or all-day 
events. The pin makes this drop-
down panel sticky. The third icon 
opens the Calendar app and the gear 
opens the menu.

There are many useful settings that enable you to customise 
Itsycal and control how it looks and the information it 
displays in its drop-down panel. For example, you can show 
and hide calendars, change the colour scheme, change how 
the calendar is displayed, and so on. Click Itsycal, click the 
gear icon and then select ‘Preferences’ from the menu. You 
can even customise the menu bar icon. Let’s take a look at 
the settings in the menu bar app.

1 General settings
Select the ‘General’ tab in Itsycal Preferences  
and at the top it can be set to automatically run 
when you log in. Set Monday as the first day of 
the week. Select the calendars you want to  
show events for.

2 Appearance settings
Select the ‘Appearance’ tab and the three 
settings at the top customise the menu bar icon. 
Try them. Choose either the Dark or Light theme 
as you prefer. Select days you want to highlight, 
such as the weekend.

Configure Itsycal

“You can customise Itsycal 
and control how it looks and 
the information it displays”



Use Google Backup and Sync
Google Drive has been available for Mac for years and it syncs 
a folder on your Mac to the same folder on other computers 
you use, whether they are Macs or PCs. Drive has been 
replaced by Backup and Sync and it has gained a bunch of 
new features. It now works similarly to macOS Sierra and 
iCloud and offers an alternative to Apple’s backup and syncing. 
Google can store the Desktop, Documents and Pictures 
folders, including your Photos library in Drive, like Apple stores 
them in iCloud. However, Google provides three times the free 
space (15GB) for files, unlimited space for photos, and syncs 
files across Macs and PCs. Some people might prefer Google 
over Apple and it is certainly something to consider.

Back up your desktop, photos and documents to Google Drive and sync across computers

Google Drive

Download available

Time needed

20

A tour of the interface
Get to know Google Backup and Sync

Difficulty

 Knowledge base

Photo and video options
Google provides High quality or 
Original quality storage for photos 
and videos. High quality is free and 
unlimited and does not affect your 
free storage. It’s for photos up to 
16 megapixels, so that means all 
iPhone photos. Storage for HD 
videos is free and unlimited too. 
Original quality is for photos over 
16MP and 4K videos. You’ll need  
a paid upgrade.

 Google Photos
Where are the photos that Backup 
and Sync uploads? Click this icon to 
open Safari to view your photos. They 
can be accessed at any time on any 
computer at photos.google.com.

 Backup  
and Sync 
The icon shows rotating 
arrows when it is syncing 
files and a static up arrow 
when it has finished. Click 
the icon to see recently 
synced files or to access 
Drive and Photos.

 Your files online
On any computer, Mac 
or PC, yours or someone 
else’s, go to drive.google.
com and you can access 
your files. Each computer 
you sync is stored 
separately and is accessed 
on the menu here.

 Google Drive
Google Drive is a folder 
on the Mac that is synced 
with Google Drive online 
and with the Google Drive 
folder on other computers. 
Click this icon to open the 
folder in a Finder window.
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Install and configure Backup and SyncStep-by-step

There are options in macOS to store files in iCloud instead of on the Mac, 
which can save disk space. Google stores them both online and offline.

Google Drive is a folder where you can store files and folders 
you want to make available on other computers – Macs or 
PCs. It is great for people who use more than one computer, 
such as one at work and at home, or who have a main 
computer like an iMac and a MacBook that they carry when 
out. Google Drive can be accessed with a browser from any 
computer and acts as a backup for your files.

1 Set Drive preferences 
Click the Backup and Sync icon in the menu 
bar, click the three dots and then Preferences. 
Select Google Drive. Turn on syncing with the top 
checkbox and either sync everything or select the 
folders to sync with the second option.

2 More settings
Select Settings and there are some useful 
options, such as whether to open Backup and 
Sync on system startup. It’s your choice. You can 
also choose to be warned when deleting items 
from shared folders.

Google Drive

“It’s great for people who use 
more than one computer, such 
as one at work, one at home”

1 Install the software 
Download Backup and Sync from google.
com/drive/download. Open the .dmg file and 
drag the app to Applications. If Google Drive is 
already installed, it will be upgraded.

2 Go to Preferences 
When Backup and Sync is run for the first time 
you are prompted to open the preferences. 
Do this at any time by clicking the menu bar 
button, then the three dots menu.

3 Choose backup options 
Select your Mac in the sidebar and use the 
checkboxes to choose what you want to store 
on Google Drive. If you need more space, 
100GB costs £15.99 a year for example.

4 Photo upload options
Click the menu item under ‘Photo and video 
upload size’. If you are not a professional 
photographer, select ‘High-quality’, which offers 
free unlimited photo and video storage.

5 File deletion options 
Click the option under ‘Removing items’. Files 
are backed up online, so if you delete a file on 
the Mac, do you want it removed online too, or 
kept? Select ‘Ask’ if unsure.

6 Remove or restore 
If the Ask option is selected for removing files, 
when deleting a file on your Mac you’ll see a 
message like this. Remove deletes it online, 
Restore puts it back on the Mac.
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1 Download VLC
VLC media player is free from videolan.org 
and is one of the most popular media players 
on the Mac. Download it, open the .dmg file, 
drag VLC to Applications and run it.

2 Listen to radio
In the Internet section of the sidebar are some 
streaming internet radio directories. Select 
‘Icecast Radio Directory’ and double-click a 
radio station to listen to it.

3 Get an add-on
Those radio stations are okay, but they are not 
the best that is available. For that we need an 
add-on for the media player. Go to the VLC 
menu and select ‘Addons Manager’.

4 Addons manager
The Addons Manager lists all the add-ons or 
extensions that have been added. This is a 
fresh install of VLC, so there are none. Select 
‘All’ and click ‘Find more addons online’.

5 Add TuneIn Radio
There are many more add-ons available from 
the VLC website, but what we want is on this 
list. Select TuneIn Radio and click ‘Install’. (The 
button becomes ‘Uninstall’ after.)

6 Select TuneIn Radio 
If you don’t see this, quit VLC and restart it. 
Select TuneIn Radio in the sidebar and the 
internet radio stations are organised into 
categories like Talk, Sports and News.

Download and use VLCStep-by-step

Time needed

10

Difficulty

VLC media player

Listen to local radio with VLC
Old-style radio has gone the way of the MP3 player and it has 
largely been replaced by better and more modern technology. 
Instead of tuning a radio into a local station, it is much easier to 
tune in your Mac and listen to streaming radio over the internet. 
Many radio stations now broadcast over the internet as well as 
over the air and there are also stations that exist only on the 
internet. Internet radio enables you to listen to talk radio, news 
stations, sports talk and local radio. iTunes can play streaming 
radio, but the choice is limited. In this tutorial we will use VLC 
media player to access a broader range of internet radio.

Use the TuneIn Radio add-on in VLC to find great local radio stations



7 Browse the stations
You can browse and play music of course, but 
Apple Music is best for that. TuneIn Radio is 
different and expanding Local Radio lets you 
see stations around the country.

8 BBC and more
There are hundreds of stations and here we 
expanded BBC Local. Just double-click a radio 
station and it begins playing in a few seconds. 
It’s great for local news and talk.

9 News and sport
The music section in TuneIn Radio is massive 
of course, but if you want something different, 
expand the News or Sport sections. There are 
some great internet radio stations.

Like traditional radio over the air, internet radio is free to listen to but is 
supported by advertising. Expect to hear occasional ads.

Listen to internet radio
Tune in to sport and other radio stations with VLC

 Knowledge base

Play iTunes radio
iTunes can be used to listen to 
streaming internet radio and 
it has a library of over 1,000 
stations. However, they tend to 
be more global and some are 
in foreign languages. There are 
plenty of US stations too. To 
access them, click the media 
menu button and select ‘Edit 
Menu’. Add Internet Radio, then 
select it in the menu afterwards.

 Manage VLC add-ons
Add-ons extend the capabilities of VLC 
and they add extra features and functions. 
Open the Addons Manager and click the 
button to find add-ons online. Select  
add-ons here if you want to uninstall them.  Local talk radio

One of the great features of VLC 
and TuneIn Radio is that it is not all 
music. There are some excellent 
talk radio shows, such as this 
sports station in London. There is 
comedy, news and more.

 Explore radio categories
TuneIn Radio is one of the most organised 
streaming radio networks and everything  
is neatly categorised, making it very easy  
to navigate. Here we are browsing by 
location (United Kingdom), and there are 
several regions.

 Internet radio 
These menu items in the sidebar 
are networks of internet radio 
stations and each one is different. 
They enable you to browse the 
stations, see what is currently 
broadcasting and to tune in and 
begin listening.
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Create and edit a podcast 
You have many options open to you when creating a podcast 
and on macOS you do actually have everything you need to 
build one in an hour. The problem is that the vast majority of 
podcasts are now professionally produced and edited in such a 
way that producing a quick and dirty audio offering will just not 
cut it in 2017. We will show you what you need to do to create 
a high-quality podcast and what equipment and software 
you need without going into too much detail. The real trick is 
starting with the right tools and then experimenting and finding 
your own style. Take as much time as possible until you are 
happy and the results will be more than worth the effort.

You can create a professional podcast on a Mac with the right equipment and software

Create a professional sounding podcastStep-by-step

Podcasts

Time needed

60

Difficulty

1 Purchase a microphone 
All Macs have a microphone, but it is crucial to 
buy a professional quality option such as the 
Blue Yeti (blue.com). This will greatly improve 
the resulting audio quality. 

2 The default software 
You can use QuickTime to make recordings 
which is especially useful if you want to 
rehearse your tone and pace before committing 
the final product for the world to hear. 

3 Professional software 
You can spend a fortune on professional 
recording and editing software or you can 
download Audacity (audacityteam.org) for 
free. It’s fully featured and fairly easy to use.

4 Hijack the audio 
If you are recording a conversation through 
Skype to broadcast as a podcast episode, 
check out Audio Hijack (rogueamoeba.com) 
as a solution to capture any audio source. 

5 Think about hosting 
Audio files take up a lot of space so consider 
using a hosting service like PodBean to host 
your files. The experience for the listener should 
be reliable at all times. 

6 Promote your work 
Consider building a website and making the 
most of social media to promote your work. 
Hosts such as Squarespace will even let you 
upload your podcast files for sharing. 
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All the tools and knowledge can’t compete with an original idea presented 
with enthusiasm. Understand your audience and subject before you start.

A perfect podcast
You need the right tools  Sound is paramount 

Audio quality is perhaps the 
most important aspect of any 
podcast, besides the content 
of course. A good quality 
microphone does not have to be 
expensive to achieve a clean and 
professional sound.  

 Editing software 
Audacity is a decent free 
option for podcast editing, 
but software such as Logic 
Pro X, GarageBand and 
WavePad are alternatives 
that will be able to take  
you even further in the 
creation process. 

 Explore  
the options 
There are many plug-ins that 
you can use after mastering 
the art of editing. Don’t 
expect to be able to grasp 
all of the knowledge that is 
required instantly, but your 
efforts will pay off.

 Start slowly 
You should start with the basics. 
Use your Mac microphone and 
QuickTime to rehearse and 
understand how you sound in 
a podcast and then you can 
move up to better hardware and 
software later on. 

You should always use the right format for your podcast 
files, one that offers high quality while remaining relatively 
small for listeners to download or stream from their mobile 
devices. MP3 is not really a format that should be used 
anymore and so we would suggest FLAC or AAC as they 
are fast becoming standards in the podcasting world. 
When using a host, a lot of the conversion will be done for 
you, but try to stick to a recognised format.

1 The export option 
In almost all audio editors, you will need to use 
the ‘export’ option to choose a specific format. 
You can save the file as a project, but look for the 
export to start the conversion process. 

2 Select the format 
Now select FLAC or AAC and then input the 
attributes that are requested. Add as much 
detail as possible to ensure that the integrity and 
tracking of the file remains consistent. 

The right format 

 Knowledge base

Understand channels
Don’t expect to just be able to 
record what is being said, even 
through a Skype call, and then 
lay it down as a podcast. You 
will need to take some time to 
understand channels and to 
edit them individually before 
you combine them for the best 
results. They are not easy to 
work with, but they are vital.  

“FLAC or AAC are fast 
becoming standards in  
the podcasting world”



2 Open the  
Parental Controls

Now go to System Preferences>Parental 
Controls, click on the padlock item 
and enter your administrator password 
and then click on the name of the new 
account in the left-hand column. You 
will now be able to select the various 
tabs at the top of the window to  
change the settings…

1  Set up user accounts
The first step is to go to System Preferences>Users & Groups. In the left column 

there should be a main admin account, but if you click on the ‘+’ icon you can create 
additional accounts for your children. Add in the account details and from the ‘New 
Account’ menu, select ‘Managed with Parental Controls’.

Your Parental Controls
Finding your way around the preferences interface

 Set up 
accounts
You can click on the 
‘+’ icon in the left 
column to add a new 
user at any time. If 
you click the cog icon 
here then you can 
even duplicate the 
settings for one  
child and use them  
for another.

 Control tabs
Check out the various tabs across the top of the 
Parental Controls window to tailor the various settings 
within to meet your child’s requirements. They cover 
all aspects of Mac use.

 Extra 
assistance
To get more information 
regarding Parental 
Controls and what you 
can and can’t restrict, 
click on the ‘?’ icon and 
you will be treated to 
more in-depth information 
via Mac Help. 

10 ways  
to protect  
your children
For those of us with families, often the household Mac is used by 
adults and children alike. In the case of youngsters, your Mac could 
be used for homework, gaming or other forms of entertainment such 
as YouTube, so it is important to get a handle on what they are using 
the Mac for and take measures to limit any harmful content that they 
may be exposed to via apps and web content. Thankfully, your Mac 
comes with a built-in set of System Preferences that allow you to 
place restrictions on all aspects of Mac use, from the content they can 
access online to the amount of time they spend on the computer.

Here we will guide you through the various options available through 
the Parental Controls and help you better protect your children so that 
they can get as much enjoyment out of your Mac as you do.

How to use your Mac’s Parental Controls

 Checking logs
Click this button to see which apps and websites 
your children have been using and visiting over 
selected periods of time making it easy to track 
their Mac habits.
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System Preferences

 Knowledge base

Censoring the web
In the ‘Web’ tab, if you click 
the ‘Try to limit access to adult 
websites’ option then you can 
click ‘Customize’ to enter the 
addresses of websites they can 
never access. This is useful if 
any parents hear of worrying 
trends and websites being talked 
about in the playground.



7 Privacy settings
Apps and services that your 

children use may frequently request 
access to their location, contacts, 
photos, etc. To prevent this, click on  
the ‘Privacy’ tab and then untick the 
various boxes to lock the current 
settings and prevent new apps from 
gaining access to them.

4 Web restrictions
Limiting the content that your 

child is exposed to on the web is vitally 
important. While you can select the ‘Try 
to limit access to adult websites’ option 
as a preventative measure for protecting 
them from unsuitable content, it is far 
safer to click ‘+’ to add websites they 
can access.

6 Time keeping
The ‘Time’ tab is where you can 

limit how much time your children 
spend on your Mac, with sections for 
weekdays and weekends and options to 
set ‘bedtimes’. This is particularly useful 
because you can paint the Mac as the 
bad guy when it automatically severs 
their access!

10 Check settings
As an extra precaution, it is 

always worth checking the settings of 
any online services that your children 
may use, such as YouTube. In this  
case, click on the user image in the  
top-right corner, then the settings cog 
and then check through the various 
settings categories. 

9 Check the logs
It is worth remembering that you 

can click the ‘Logs’ button in the lower-
right corner of the Parental Controls 
preferences at any time to see which 
apps your children have used and which 
websites they have viewed. This makes 
it easy to track their Mac habits.

3 App restrictions
Don’t be afraid to play it safe, untick ‘Allow use of Camera’, as nobody 

needs to see your child and tick ‘Limit Mail to allowed contacts’. If you tick ‘Limit 
Applications on this Mac’ you can cherry pick the apps that your child can and 
cannot use while using the Mac.

Whenever you make changes to Parental Controls preferences, make sure 
you click on the padlock icon again to close it and prevent further changes.

5 Store access
Under the ‘Stores’ tab there are 

various dropdown menus to choose the 
age rating of content that your children 
can download. However, it may be best 
to disable access to all of the stores 
in general – after all, whose money are 
they potentially spending?

8 Other business
The ‘Other’ tab provides a list of 

other apps and services that you can 
restrict for youngsters. This includes 
explicit words in the Dictionary app, 
turning off Siri and even requesting a 
simplified version of Finder for young or 
inexperienced users.
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The many ways 
in which your 

iPhone can be 
used in times 
of emergency

We use our iPhones for so many 
different purposes every day that 
we sometimes forget that it also 

has the power to save our lives or the lives 
of others around us. We’re not talking about 
simply phoning for help – we’re talking about 
entering our important health information 

into a Medical ID that is easily accessible by 
other people, even if your iPhone is locked. 
We’re also talking about your location being 
tracked so that emergency services can find 
you if you get into difficulty. And what if you’ve 
been taken hostage? You can also use your 
iPhone to contact the emergency services and 

communicate with them without speaking.
There is so much that your device can do to 

preserve your welfare, but you have to know 
what the key apps and services for this purpose 
are, how to set them up and how to activate 
them in times of trouble. So read on to find out 
how your iPhone can help you in an emergency.



You can update the information in your Medical ID at any time by opening 
your Health app, tapping on ‘Medical ID’, scrolling down and tapping ‘Edit’.

Your Medical ID

Probably the single most important 
step to preserving your own wellbeing 
that you can take on your iPhone is 
setting up a personal Medical ID. 
Part of the Health app, your Medical 
ID holds key information relating to 
your medical needs, including any 
medications that you are currently 
taking and any allergies that you may 
have. So if you are injured or knocked 
unconscious and cannot relay this 
information to the emergency services 
personally, they can access your 
Medical ID and glean the info that  
they need without having to unlock 
your iPhone.

How to make your key medical 
information available to others

1 Open Health app
Launch the Health app, which is 
an Apple default installation on 
your iPhone, and enter your basic 
information, such as name, date of 
birth, height and weight. Then tap 
on ‘Continue’.

4 Add in details
Work your way down through the 
page, adding in all of the required 
info that you are willing to divulge, 
such as ‘Medical Conditions’, 
‘Medical Notes’, ‘Allergies & 
Reactions’ and ‘Medications’.

2 Tap to create
On the next screen you will be 
invited to start creating a new 
Medical ID. Tap on ‘Create Medical 
ID’ and then you will be able to 
start entering the important info 
that could save your life.

5 Add contacts
This is another highly important 
one. Tap on the ‘add emergency 
contact’ option and pick a name 
from your contacts. Tap on the 
applicable relationship. When 
you’re happy, tap ‘Next’.

3 Enable option
The most important option is the 
first thing you’ll see, so make sure 
that the ‘Show When Locked’ 
option is enabled to allow other 
people to view your Medical ID 
without unlocking your iPhone.

6 Review
Your Medical ID should now be 
completed, so review all the data 
you’ve entered, then tap on the 
‘Done’ button to complete the 
procedure and store your key info 
away for safekeeping.

“Your Medical 
ID holds key 
information about 
your medical needs”
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How to access your Medical ID

Filling in your Medical ID
When filling in your Medical ID, 
it is important to input as much 

information as possible that could prove crucial in the 

event of someone else needing to view it. Fortunately, 
inputting data is quick and easy thanks to the Health 
app’s simple input interface. Here’s how it works.

 Fill in sections
All of the key information that 
you can input into your Medical 
ID is broken down into sections. 
For the initial sections, such 
as ‘Medical Conditions’ and 
‘Allergies & Reactions’, tap and 
type the information in.

 Donate organs?
Tapping on the ‘add organ 
donor’ option presents two 
options – ‘Yes’ or ‘No’. This is an 
alternative to carrying around an 
Organ Donor Card and you are 
effectively giving your consent 
here to donating your organs in 
the event of death.

 Adding stats
Other sections, such as ‘Blood 
Type’ and ‘Weight’, when tapped, 
allow you to select the applicable 
information from a useful menu. 
It would certainly help if there 
was an in-app convertor to 
change stones into kilograms 
etc, though…

 Finishing up
When you have entered as much 
medical information as you know, 
tap on the ‘Done’ option. You 
can go back into your Medical ID 
via the Health app and edit the 
information at any time if any of it 
changes down the line.

Presenting all of your key medical information

1

2

31 Tap on 
Emergency
On your iPhone’s Lock screen, 
tap on the ‘Emergency’ option 
in the lower-left corner of the 
screen. Anyone will be able 
to access this without having 
to enter a code to unlock the 
iPhone first.

2 The emergency 
call screen
You will be taken to the 
emergency call screen that 
presents a telephone keypad 

for anyone to use in order 
to contact the emergency 
services. Now tap on the 
‘Medical ID’ option in the 
lower-left corner.

3 Access the 
Medical ID
Your Medical ID can now 
be viewed by anyone who 
needs to see it. All of the key 
information will be instantly 
apparent, including any 
allergies and your blood type. 
Tap ‘Done’ to dismiss.

iOS SOS
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To prevent your Apple Watch accidentally calling the emergency services 
open the Watch app on your iPhone and go to General>Emergency SOS.

Using your Phone 
app in an emergency

1 Dial the number
Key in the number for the emergency services 
(which is ‘999’ in the UK) and you will be asked 
what service you require. If you don’t answer 
you will be asked to make a sound to indicate 
that you may be in trouble.

2 Remain silent
If making a sound would put you in greater 
danger, such as alerting an attacker to your 
presence, for example, stay silent and the 
operator will put you through to an automated 
system called the Silent Solution.

3 Dial ‘55’
Once you have been put through to the Silent 
Solution system, dial ‘55’ on your iPhone 
keypad. This will instantly alert the police to 
your danger and attempts will be made to 
discover your location.

If you own an Apple Watch you 
can send out a distress call from 
your wrist as long as your iPhone 
is nearby. If you need help, press 
and hold the side button for a few 
seconds and you’ll be taken to the 
Power Off screen, which features 
an ‘Emergency SOS’ option. Slide 

thi ll mergency services 
( tinue holding 

d wn the button to 
have the Watch 
call it for you) 
and they will get 
your current 
location and 
your iPhone 
will also 
contact any 

SOS contacts 
stored in your 

Medical ID.

Watch alert

Calling the emergency 
services on your iPhone 
is the obvious way to get 
help if you are injured or in 
danger, but what if making 
a sound could potentially 
make the situation worse 
and increase the potential 
risk to your health? 
Thankfully, the emergency 
services have steps in 
place for such situations. 

Called the ‘Silent Solution’, 
this system lets them 
distinguish between an 
accidental call and a very 
real situation and ensure 
that the correct help is 
deployed. If the police 
can’t track your location 
without extra assistance 
then they may ask further 
questions that you can 
respond to with taps.

Discover how you can call for help 
without speaking

this to call em
(or cont

dow
h

M
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Tracking your location

Your tracking device

The built-in tracking capabilities of the iPhone 
could prove to be a real lifeline if you or 
someone that you love gets lost. Through 
apps such as Maps, Find My iPhone and Find 
My Friends, your location and the location of 
friends and family can easily be tracked. To 
ensure that your device can be traced, go to 
Settings>Privacy>Location Services and ensure 
that Location Services is turned ‘On’. Then tap 
on the ‘Share My Location’ option and ensure 
that it too is activated for your current device. 
We will now explore how best to utilise your 
iPhone’s Location Services.

Your iPhone’s built-in Find My iPhone and Find My 
Friends apps are a great way to help ensure the 

safety of you and your family. Here we demonstrate 
how to best use them to your advantage.

 What’s nearby?
Other useful information provided 
by the Maps app includes places 
nearby. So if you are trying to get 
help to you or someone else, you 
can tell the emergency services 
the nearest postal address to 
help them find you better.

 Open Maps
If you are lost then there is a 
handy feature in the Maps app 
that you can use to relay your 
exact location to other people. 
Start off by tapping on your 
current location (blue dot) and 
then pull up the options drawer.

 Your co-ordinates
Another useful piece of 
information to pass on to the 
emergency services is your  
exact co-ordinates. The 
co-ordinates for your latitude  
and longitude will be presented 
in the Maps app for you to relay 
for sat nav purposes.

 Share your location
You will see two main options – 
‘Mark My Location’ and ‘Share 
My Location’. The first will 
pinpoint your position with a red 
pin and the second will allow you 
to share your location with other 
people via a wide range of apps.

The tracking capabilities of the iPhone can prove 
vital in finding missing people

Utilising Location Services to track yours and your family’s iPhones

1 Log on to iCloud
Make sure a family member knows your Apple 
ID/password. If you go missing with your 
iPhone, they can log in to icloud.com.

2 Click ‘Find iPhone’
The iCloud page has a wide range of apps 
and services. Click on ‘Find iPhone’ and all 
associated devices will be presented on a map.

3 Pinpoint device
Click on ‘All Devices’ and select the iPhone. 
The location of this device will then be 
pinpointed on a map. Zoom in for more detail.

iOS SOS
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Remember, you will need to activate the ‘Access When Locked’ feature in 
Settings>Siri to use the “Hey Siri” feature when your iPhone is locked.

How to use Find My Friends
If you have iPhone-owning children then the 
Find My Friends app is a useful way to monitor 

their movements and check that they get to where they need to 

be. The app is easy to use and comes with a wealth of options, 
such as getting notifications when they arrive at and leave 
certain locations, and contacting them in an emergency. 

Discover how to track your friends and family

1 Tap to 
‘Add’ folk
When you launch 
the Find My 
Friends app you 
will see a map 
and a blue dot 
to indicate the 
location of your 
iPhone. Start 
adding family 
members to the 
map by tapping 
‘Add’ in the top-
right corner.

2 Pick 
contacts  
to add
You can add 
people nearby via 
AirDrop, if their 
devices appear 
in the window, 
otherwise tap 
on the ‘+’ icon 
in the ‘To’ field 
and then pick a 
person from your 
contacts list to 
add to the app.

3 Send out 
the invites
Once you have 
selected a 
contact, tap 
on their phone 
number and 
their name will 
be added to the 
‘To’ field. When 
you have finished 
adding contacts, 
tap on the ‘Send’ 
option in the top-
right corner.

4 Time 
period
A pop-up menu 
will now appear 
displaying options 
for the period of 
time you want 
to share your 
location. If you 
are adding your 
children, for 
example, the 
‘Share Indefinitely’ 
option is worth 
considering.

5 Tap ‘Ask  
To Follow’
When the person 
has been added, 
you can then tap 
on their name in 
the list and tap 
on the ‘Ask To 
Follow’ option.  
A request to 
follow them will 
then be sent 
to that person. 
Wait for them to 
accept the invite.

6 Track 
people on 
a map
When the 
invite has been 
accepted, their 
location will 
appear on a map 
and you will be 
able to track their 
position. You will 
also see options 
to get notified 
when they arrive 
at or leave places.

Asking Siri for help
Call on Siri’s assistance in an emergency

1 Go to Settings
Go to Settings>Siri and 
ensure that Siri is turned 
on. Further down the 
screen of options you 
will see the ‘Allow  
“Hey Siri”’ feature. 
Ensure that the slider 
is moved to the ‘On’ 
position and you will 
initiate the set-up.

2 Set up Siri
You now need to say, 
“Hey Siri” three times 
followed by a couple 
more phrases so Siri 
can recognise your 
voice and calibrate. 
Once the process is 
complete, tap ‘Done’ 
and Siri can now listen 
out for your commands.

3 Ask Siri to help
In an emergency, you 
can now say, “Hey Siri, 
call 999”. To ensure 
that you haven’t made 
the call in error, Siri will 
initiate a five second 
countdown before 
calling. You can cancel 
the command during 
this countdown.

If you are trapped and unable to reach your 
iPhone, you can still contact the emergency services to get the 
help you need – just ask Siri. If you have the ‘Hey Siri’ hands-free 
feature set up then you don’t need to touch your iPhone at all. 

As long as your iPhone is within range, just say, “Hey Siri, call 
999” and Siri will do it for you. Siri will begin a short countdown 
before calling, giving you time to assess your situation or cancel 
the call in case it turns out to be a false alarm.



Your iPhone Survival Kit
How to best utilise your iPhone’s built-in safety features…
Your iPhone is rammed with apps and services to track 
your position and provide the tools you need to get out of a 
sticky situation – some you may use frequently, others you 

may have forgotten about completely. So here we provide 
a handy checklist to remind you of your iPhone’s key safety 
features and how to set them up.

Make use of the flashlight
Whether you’re walking home alone 
at night, trying to find your tent at a 
festival or you need to use your device 
as an emergency beacon, your iPhone’s 
built-in flashlight can be a huge help. 
To activate it, swipe up to access your 
Control Centre and then tap the torch 
icon. If you have an iPhone 6S or higher 
you can also press down on this icon to 
determine the brightness of the light.

Set up a Medical ID
If you fall ill and need urgent medical 
attention then setting up your own 
personal Medical ID within your iPhone 
means you can get the help you need 
quickly. Your Medical ID contains 
info such as medical conditions, 
medications, allergies, etc, and can 
be accessed from your iPhone’s Lock 
screen in the case of an emergency. So 
make sure you fill it in.

Use the Compass app
You probably never use it, but your 
iPhone comes with a built-in Compass 
app to help you navigate. What’s handy 
about the Compass app is that it 
provides accurate co-ordinates to your 
current location and elevation which 
can easily be relayed to emergency 
services over the phone. You can also 
go to Settings>Compass to set it to 
‘True North’ instead of magnetic North. 

Set up “Hey Siri”
If you get trapped or injured and find 
yourself in a situation where you can’t 
physically reach your iPhone you can 
still shout out to Siri and get your 
iPhone’s personal assistant to call the 
emergency services for you. Go to 
Settings>Siri and make sure that Siri 
is turned on. Then activate the ‘Allow 
“Hey Siri”’ feature and go through the 
set-up process.

Utilise ‘Do Not Disturb’
Your iPhone’s built-in ‘Do Not Disturb’ 
function blocks out all incoming alerts 
and distractions and is perhaps most 
commonly used at night. However, you 
should always try to utilise this feature 
when you get behind the wheel of your 
car to avoid getting distracted while you 
drive. To instantly activate this feature, 
swipe up to access your Control Centre 
and then tap on the moon icon.

Enable Location Services
Location Services uses GPS, Bluetooth 
and crowd-sourced Wi-Fi hotspots and 
mobile tower locations to work out your 
approximate location. This information 
is essential to apps like Find My iPhone 
and Find My Friends that track the 
location of your device in the event 
of it getting lost or for safety/social 
purposes. Go to Settings>Privacy> 
Location Services to turn it on.

Set up Apple Pay
Though you may not use Apple Pay 
regularly, it is well worth setting up just 
in case you lose your wallet and find 
yourself marooned without any cash 
for emergencies. Go to Settings>Wallet 
& Apple Pay and then tap on the ‘Add 
Credit or Debit Card’ option. You can 
now add in your card details so that 
you will be able to use your iPhone to 
pay for essentials.

Get to know the Maps app
Your iPhone’s default Maps app has 
numerous uses beyond that of basic 
navigation. For example, if you wind up 
in unfamiliar surroundings then you can 
use the app to discover what’s around 
you – useful if you need nourishment or 
fuel. If your car is equipped with Apple 
CarPlay then you can use Maps to track 
the location of your vehicle if you forget 
where you parked.

iOS SOS
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Apple will take ‘Do Not Disturb’ further in iOS 11 with ‘Do Not Disturb While 
Driving’ which kicks in automatically when you get behind the wheel.

LifeSaver 
Free
A precursor to Apple’s 
own ‘Do Not Disturb 

While Driving’ feature that is heading 
our way in iOS 11, LifeSaver locks up 
the user’s iPhone when the car is in 
motion to prevent them from being 
distracted by notifications when they 
are driving.

Find My Kids
Free
This app lets you track 
the movements of 

children or loved ones and allows 
you to set up Geofences – such as 
schools – and be notified when these 
fences are crossed. The app can also 
let you know when your teenagers 
go over the speed limit!

Weather Pro
£1.99/$2.99
If you regularly enjoy 
the great outdoors then 

this weather app could be a potential 
lifesaver because it will send alerts to 
your iPhone when extreme weather 
is moving into your area, allowing 
you plenty of time to take the 
necessary precautions.

iTriage
Free
Designed to provide 
quick and easy access 

to medical care, iTriage allows you 
to look up any symptoms of illness 
that you may present and help you 
get the required care by finding 
the nearest medical facility to your 
current location.

StreetSafeApp
Free
This app lets you notify 
family and friends to 

your whereabouts and if you are in 
danger you can tap an in-app panic 
button to send SMS alerts and push 
notifications to your loved ones 
sharing your location and pictures.

Circle of 6
Free
By adding up to six 
trusted friends to your 

circle, if you find yourself in an 
uncomfortable situation then you 
can use this app to send your circle 
a pre-programmed SMS message 
showing your exact location.
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Further apps for 
keeping safe
Essential downloads to help protect you
As we have already outlined, your iPhone 
comes with numerous built-in features to 
help preserve your safety, but there are 
third-party apps available from the App 

Store that are worth considering too. Here 
we pick out a selection of apps that we 
consider to be the most effective for all 
types of situations…



Add personality 
and variety to 
your messages 

Text messages have historically been exactly that 
– simple text used to communicate with others. 
iMessage, however, has grown into a complete 
platform that can be used to keep in touch with 
those most important to you in a variety of useful 
and fun ways. Messages does work very well on 
a Mac, but at this time the boundaries are being 
pushed by Apple on the iPhone and iPad. With 
stickers, fun additions and even games, you and 
others can communicate as if you are in the same 
room no matter where you are. Let’s take a closer 
look at Messages, in particular on an iOS device…

iMessage is more than just a way to 
communicate with words. It’s a fun and 
complete communications platform

Enhance your messaging experienceStep-by-step

Messages

Time needed

5

Difficulty

3 Play with games 
There are many turn-based games 
available for iMessage. Experiment 
with a few of these to see which 
play best because the quality can 
vary from excellent to terrible. 

2 The blue icon 
Tap the blue App Store icon and 
you will be taken to all of the 
iMessage related apps and sticker 
sets. You may be surprised at how 
large this section of the store is.  

1 GIFs work best 
When you are in a conversation 
and want to add some humour or 
realistic emotion, tap the red icon 
with a magnifying glass and search 
for a funny GIF to suit the chat.  

4 App extensions  
Many apps now automatically 
install extensions which are 
accessible in Messages. Pocket 
lets you share interesting articles 
and clips instantly with friends. 
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If you love sending expressive messages then revisit the App Store through 
Messages regularly to see what’s new, as there will undoubtedly be lots!

7 Stickers are fun 
If you and a loved one have a 
shared interest in a particular topic, 
it is likely that there is a related 
sticker set available. This is a great 
way to personalise a conversation. 

5 Music for everyone 
If you are subscribed to Apple 
Music you can tap the Music icon 
to share tracks you have recently 
played with others. The message 
requires one tap to play the track.

8 Where are you? 
You may need to think about 
Messages in a new way because 
you can do things like share your 
location in Google Maps as well – 
no more jumping between apps. 

6 Get to work 
iCloud is obviously accessible 
throughout iOS, but you can 
also share files that are stored in 
Dropbox through an iMessage – 
useful for work-related activities. 

Add effects
For special messages, tap and hold 
the blue arrow to the right and then 
select ‘Screen’ to use a variety of 
clever effects that fill the entire 
screen with colour. 

Add weight
In the same screen, selecting 
‘Bubble’ at the top lets you change 
the way the text is displayed. It can 
slam onto the screen, be gentle and 
even be written in invisible ink.

Built-in personality

Draw your message
While in the creation panel, tap 
the blue icon and you can draw 
an animated message. Take your 
time drawing and you can create 
something very impressive.
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load available

me needed

10

Difficulty

an ahead with the 
iPlanner app

We have calendars and task lists to help us get things done 
which work well for complex work projects and day to day 
activities, but there are times when they can feel inconvenient 
and just take too much time to input repeating events. iPlanner 
UK lets you create a visual plan that is easy to refer to and 
which is much more efficient at dealing with specific event 
patterns. It is ideal for shift patterns at work and for managing 
holidays, but it also has many other tricks up its sleeve which 
can be used to share your plans with others and to help you 
avoid conflicts with family and friends. If you use the app to its 
full potential, you’ll find that the rewards will come quickly.

ner can take care of your day, your month 
your entire year with ease

iPlanner

Create a visually smart plannerStep-by-step

1 The year ahead 
When you first open iPlanner you will be 
presented with a standard yearly calendar view 
which is yours to populate as required. Tap any 
date and a new panel will open.

2 Build an event 
Tap the ‘Category’ option at the top and create 
a new one by following the simple visual cues. 
Make sure that the icon you choose to define it 
is visually suitable. 

3 Dates and repeats 
Now enter the start and finish times of the event 
and if required build a repeat. The repeating 
feature is particularly useful for scheduled and 
consistent events.

Down

Tim

D

iPlan
and y
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A perfect  
visual planner
Multiple features in a 
simple interface

 Choose your look 
You can customise the way iPlanner 
displays your events with a variety 
of colours and looks. Your perfect 
interface will be just a couple of  
taps away. 

 Build it up 
The more you add to iPlanner, the more 
useful the app becomes. Potentially you 
could be using it for many years and benefit 
from it every single day. 

 Integrate your calendars 
You can integrate calendars as well  
to bring all of your important events  
under one roof. Again, they are added 
with a consistent approach that adds  
little clutter. 

iPlanner is also available for the iPad, Mac and even Android. With iCloud, 
you can use it anywhere you choose and stay updated continually.

 Knowledge base

Multiple choices
Your iPlanner data can be backed up to Dropbox, 
online with iCal integration and of course through 
the standard iCloud backup feature. You can also 
share your plans through email and via the sharing 
and printing of PDF files. It is only when you look 
behind the simplistic interface that you realise just 
how much power is available.

4 A tiny event 
The newly created event will appear on the year 
grid and it looks tiny. When you add more with 
different icons, your future will suddenly seem a 
lot more organised. 

5 Change your view 
You can use the tabs at the bottom of the 
display to change the way events are displayed. 
You may find that the monthly or weekly views 
are sometimes easier to manage. 

6 iPlanner with iCloud 
Make sure you explore the iCloud features 
because they will ensure you don’t lose your 
plan and they also give you the ability to share 
plans with family and co-workers. 

 Back it up 
iCloud integration has been well 
implemented and provides peace of mind 
for your carefully created plan so that you 
are unlikely to ever lose your data.
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1 Sign in
Download and install the free Sky+ app from 
the App Store and then sign in using your Sky 
ID. You will now be able to access the main 
menus of your Sky+ box.

2 View TV Guide
Tap on the ‘TV Guide’ option and you will be 
able to view all of the TV stations. Tap on  
one to view its extensive schedule for the 
forthcoming week.

3 Record shows
When you find what you want to record, tap 
‘Record’ followed by ‘Record once…’ or, if 
applicable, ‘Record series…’ – once done you 
will never miss a show.

Record shows remotely

The beauty of being a Sky+ subscriber is that you can fill up your Sky+ 
HD box with your favourite shows, scheduling them to record over entire 
seasons. However, what if you forget to schedule a recording in advance 
and only realise that you have forgotten to record a show when you are 
already out? Not a problem, just download the free Sky+ app.

With this app, you simply sign in to your account using your Sky ID and 
your iPhone will be instantly connected to your Sky+ HD box at home. 
Now you can browse through the entire TV listings, using the familiar menu 
system that you use on your box and you can schedule recordings or 
instantly start recording shows remotely over Wi-Fi or mobile data. It’s a 
handy way to ensure that you never miss your favourite TV shows again.

Never miss your favourite TV shows with the Sky+ app

Sky+

Using the Sky+ appStep-by-step

Time needed

5

Difficulty
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Time needed

5

Difficulty

Create a digital 
business card

Remember the days when you had to carry around a stack 
of business cards and hand them to people who you wanted 
to connect with? Well, you probably don’t now, but that isn’t 
really the point of Ping. It does replace paper business cards 
perfectly and will help you share the information that others 
need to understand who you are and what you do, but it is the 
seamless way it handles the process that makes it worth trying 
out. Setup is very simple and quick and with some time spent 
crafting a description of yourself that is both self-promoting and 
informative you will find that new connections you make are 
much more likely to become long-standing relationships.

Share your personal information digitally and create 
more networking opportunities with the Ping app

Ping

Build a digital business profileStep-by-step

1 Getting started 
Once you have downloaded the app you will 
need to follow the setup process and log in 
with a validated email address. The entire 
process will not take long to complete. 

2 Your new profile 
After answering a few questions your profile 
will be created. It is a bare bones profile at this 
stage, but gives you ideas on what you can 
add to it to increase its value. 

3 A quick share 
The app will always open on the screen where 
you can share your personal details. This is 
ideal for when you want to share something 
with someone you have just met. 
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Create 
and share
An informative digital 
business card experience

 Get work 
The ‘Ways I can be helpful’ panel is ideal for 
advertising your skills to people you meet. 
It is possible that Ping could enhance your 
earning potential overnight. 

 No settings? 
The app and related service have been built 
so as to minimise the need for any settings. 
There is little to learn and thus very little to 
go wrong. 

 It is personal 
In your digital profile you can add requests to the ‘I’d like to 
learn about’ section. This is likely to help build collaboration 
from those who can help you.

Your current location is added to new contacts so that you can always 
remember where you met them. Familiarity is useful in business. 

 Knowledge base

Be sensible
Ping is designed to offer little tangible information about you 
by default, but you can add anything you like such as phone 
numbers and addresses. We would, however, advise you 
to use common sense when sharing with people you have 
just met and to maybe limit some personal data that could 
possibly be used for the wrong purposes.

4 Just one email 
All you have to do now is enter the email 
address of the other party and your digital 
business card will be shared immediately. The 
sharing process could not be easier. 

5 Enhance your profile 
We would strongly suggest that you enter as 
much relevant information as possible in the 
‘Edit Profile’ section. This is what makes Ping 
better than paper business cards. 

6 Dealing with contacts 
All of your Ping contacts will be listed and 
accessible through the ‘Contacts’ tab at the 
top. Simply tap any one to view and act upon 
the contact information you need. 

 Instant contacts 
All you will need to do when you meet someone new is ask for 
their email address to share your new digital business card. It 
will take a few seconds.
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Download available

Time needed

5

Difficulty

Repost your 
Instagram content

One of the best things about Instagram is swiping through 
other people’s posts – but what if you want to share one of 
these on your own Instagram feed? In-app, no such feature 
exists but there are other free third-party apps to perform the 
task for you, one of which is Repost for Instagram. The process 
is actually quick and easy once you know how, and we’ll guide 
you through it here. When sharing posts, you are invited to 
credit the original poster in your reposts. However, this can be 
cropped out when you return to the Instagram app leaving you 
with a moral quandary – do you populate your own window 
with other people’s talent? We’ll leave you to ponder that one.

How to use the Repost to Instagram app to share 
great content that you come across in Instagram

Instagram

Reposting in InstagramStep-by-step

1 Download the app
The Repost for Instagram app is free from the 
App Store. Once it has been downloaded, go 
back to using the regular Instagram app until 
you stumble across something cool.

2 Find great content
When you discover an Instagram post that you 
would like to share with your own followers, tap 
on the ‘…’ icon in the top-right corner of the 
interface and a menu of options will appear.

3 Copy the URL
All of the options will relate to different forms of 
social media but what about Instagram? Tap on 
the ‘Copy Share URL’ option and then the ‘Link 
copies to clipboard’ message will appear.
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Reposting 
made easy
Getting to know the 
Repost interface

 Repost button
Tapping the ‘Repost’ button and choosing 
‘Copy to Instagram’ will take you back to the 
Instagram app to make your own cosmetic 
edits to the image.

 Credit where due
When you repost Instagram content you will 
credit the original poster. Use the icons at 
the bottom to determine where the credit 
sits within the image of your repost.

 Choose colour
You have the added option of choosing whether the original 
poster’s credit is set against a light or dark background. The 
lighter option is certainly the most subtle.

You can upgrade to the ‘Pro’ version of Repost in-app by tapping the ‘no 
credit’ icon. It costs £4.99 for no ads and removable post marks.

 Knowledge base

Cropping shared images
When you take the shared post back into the Instagram app 
from the Repost app, you will have the option to crop the 
copied image. If you do then you could instantly eradicate the 
original poster’s credit that you added in Repost. We’ll leave 
you to decide if you can live with yourself after committing 
such a crime!

4 Open Repost
Double-tap your Home button and swipe right 
to the Repost app and your copied URL will 
appear in the form of the original Instagram 
post at the top of the screen – tap to select it. 

5 Choose style
The original poster will be credited in your 
repost, so pick an icon at the bottom of the 
screen to represent where the credit will appear 
and choose whether the credit is light or dark.

6 Tap to repost
When you are ready, tap on the ‘Repost’ button 
at the bottom of the screen and then choose 
‘Copy to Instagram’. You can now filter, edit 
and caption the post as normal before sharing.

 Open in Instagram
You can view the original post at any time by tapping on the 
share icon and choosing the option. This is actually the only 
option so it is somewhat hard to miss!
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Download available

Time needed

10

Difficulty

Explore the world 
with Google Earth

Although Google Earth was given a huge revamp in April for 
the web and Android, it has taken a bit longer to reach iOS. 
Fortunately, it has been worth it, with a speedy, freshened up 
app that’s packed with fantastic imagery and a great jumping-
off point for anyone keen to discover new places. Two years in 
the making, Google Earth has asked scientists, organisations 
and storytellers to guide you on a journey to the four corners of 
the globe. As you fly over cities and get down on the ground in 
remote villages, you can view maps in 2D and 3D, learn more 
about the locations you visit, get random inspiration and even 
take a photo of the places you encounter to share with others. 

A new version of Google Earth has been launched 
on iOS and it’s out of this world

Google Earth

Enjoy a fun world tourStep-by-step

1 Install Google Earth
Go to the App Store and install or update 
Google Earth, then open it. You’ll be faced with 
an image of the globe and you can pinch and 
pull your fingers to zoom in and out.

2 Search for locations
Tap ‘Search’ at the top of the screen and you 
can type a location. Not sure of a place name? 
You can input queries such as “capital of 
Germany”. Tap ‘Search’ to be taken there.

3 Read Knowledge cards 
Google Earth has cards packed with history 
and trivia about locations worldwide. Swipe left 
and right for more, and scroll to read. Tap the 
blue icons to visit the locations.
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Tour locations 
using Voyager
Use Voyager to tour numerous  
cities and stunning countryside

 Visit some cities
You’ll find 17 cities as well as far-flung 
locations such as the South Pole 
and remote islands and some quirky 
destinations (historic tennis stadiums, 
anyone?) by clicking ‘Travel’.

 Interactive stories
Voyager is all about telling stories and 
there are certainly lots of them. Look 
through the Editor’s Picks to start with, 
tapping anything you like the look of. 
You can then go on a tour.

 Explore nature
When you select a category such as 
Nature and choose a story, you can tap 
left and right through a series of pages. 
The idea is that you get to learn more 
about a destination.

When you tap 3D, Google Earth’s camera will also hover over the location 
you are viewing which is similar to Flyover in Apple Maps.

 Knowledge base

Want to go somewhere random?
Although most of us will go straight to our own 
houses when first visiting Google Earth, the app 
makers want to encourage greater exploration. You 
will see an icon which looks like a dice at the top of 
the screen. By tapping this ‘Feeling Lucky’ button 
you can leave it up to Google Earth to determine 
where you should be heading.

4 View in 3D
You can view locations in 3D. Just tap the 3D 
button in the bottom-left corner and use two 
fingers to move around the image, seeing it 
from various angles, up-close and far.

5 Enjoy street views
Want to get down to street level? Tap the 
person icon bottom-left and select a blue dot 
on the street. Street View will load and you can 
look around a location ‘on foot’.

6 Take a photo
If you would like to create a postcard of a 
location, use two fingers to adjust the image, tilt 
it into 3D, and press the camera button. You’ll 
be given sharing options.

 More categories
Keep swiping left here and you will see 
more categories. As well as Culture, 
there is History and Education. Voyager 
is a wonderful way to see parts of the 
world you may never have considered.



68

Download available

Time needed

5

Difficulty

Back up your health 
and activity data

We’d hazard a guess you’ve never attempted to back up 
your Watch. How do we know? Because it does it for you 
automatically. All of your vital Watch information gets stored on 
your iPhone – and that, in turn, is saved to iTunes every time 
you plug in and back up your iPhone. But if this is your primary 
method of backup, you may find there’s an omission. Unless 
your backups to iTunes are encrypted, the health and activity 
data you’ve built up by using your Watch won’t be going with it. 
Here we show how you can ensure that it will. 

Make sure any achievements/exercise information 
you store on your Watch is backed up to iTunes

iTunes

How to encrypt your backupsStep-by-step

1 Open iTunes
Your Watch data is automatically backed up 
to your iPhone. You just need to ensure your 
health and activity data saves when backing up 
to iTunes. Open iTunes on your computer.

4 Set a password
You’ll be asked to enter a password to protect 
your iPhone backup. Do all you can to commit 
this to memory because there is absolutely no 
way to recover it if you forget.

2 Connect your iPhone
Now connect your iPhone to your computer 
and click on the iPhone icon which you will see 
towards the left-hand corner of the iTunes app. 
This displays details of your phone.

5 Check it works
After iTunes backs up your data, click 
iTunes>Preferences (or Edit>Preferences on a 
PC), select the Devices tab and then look for a 
padlock next to the encrypted backup.

3 Select Encrypt
On the Summary screen, tick the option for 
‘Encrypt iPhone Backup’. This will ensure your 
Health data is backed up – letting it flow nicely 
from your Watch to your iPhone to iTunes.

6 Change the password
Now when you amass any health data on your 
Watch, it will transfer to your iPhone and then 
on to iTunes. You can change your encryption 
password by clicking ‘Change Password’.
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Tailor the backup options

For privacy reasons, if you do not encrypt the data that is backed up to 
iTunes, then you will not be able to save your health and activity data.

You can tell iTunes exactly how you want your data 
to be backed up and synced

 Encrypting backups
As well as allowing you to back 
up your health and activity data, 
ticking this box will also save your 
passwords, Wi-Fi settings and 
website history to iTunes.

 Stop backup encryption
If you have selected to encrypt your 
backups and you change your mind, 
just untick this box. Be warned, 
though, if you’ve forgotten your 
password you won’t be able to stop  
it encrypting.

 Syncing options
Here you can select whether you 
want to sync your iPhone over Wi-Fi, 
select certain songs and videos to 
sync and inform iTunes of the quality 
you expect from your media.

 Knowledge base

Saving to iCloud
If you prefer to make your 
backups in Apple’s iCloud rather 
than by using iTunes, then you 
need not worry about your 
health and activity data. That’s 
because backups to iCloud 
are automatically encrypted 
so such data is always saved. 
The problem of your health and 
activity data becoming lost is 
solely an issue for anyone who 
uses iTunes to backup.

 Automatically sync
To save you having to click ‘Back 
Up Now’ in the box above, you 
can tick this option to ensure your 
iPhone automatically syncs when 
it is connected to iTunes – taking 
your Watch data with it.
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wnload available

Time needed

2

Difficulty

Use your Watch as 
n alarm clock

Many of us already use our iPhone as an alarm clock but did 
you know that the Apple Watch makes for an even better 
wake-up device? By fastening the strap, you can stand the 
Watch on its side, making it easier to see the display when 
you nudge it to wake. It is certainly better than using your 
tired limbs to lift your iPhone to see the screen! What’s more, 
because you need to have the charger plugged in to the Watch 
to activate the alarm clock, you can also ensure your wearable 
is fully juiced up for the busy day ahead.

Here we look at how you can put your phone into the 
Nightstand mode and also how you can set the alarm and 
edit it so that it works exactly the way you’d want it to. If, for 
some reason, you’re having problems, open Settings and go to 
General>Nightstand Mode. Here you can make sure the mode 
is turned on – or turn it off by moving the slider if you don’t 
think you’ll benefit from the feature.

nt to get some shuteye but still make use of your 
tch overnight? Turn it into an alarm clock

Apple Watch

A i h Ni h d odeS p y p

1 Position the Watch
Turn the Apple Watch on to its side so that the 
Digital Crown and the main button are on the 
top of the device. You may want to fasten the 
strap so that it stays upright.

2 View Nightstand mode
Once you have done that, connect the Watch 
to the charger. When the juice flows and the 
Watch begins to charge, the device will enter 
what is called the Nightstand mode.

3 Wake the Watch
The Watch will automatically flip into the 
horizontal position and show the time and 
date. To see the time at night, press one of the 
buttons or move the device slightly.

Dow

T

Wan
Wat

Activate the Nightstand moStep-by-step
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Editing the alarm

Want to set an alarm without the hassle of tapping around in the Alarm app? 
Just ask Siri to “Wake me up at” or “Set an alarm for” and tell it the time.

Make sure you are not being 
woken on the wrong days and 
maybe even allow yourself a 
little extra nap time

 Have a snooze
Fancy nodding off back to sleep 
but you’re worried that you will 
be late for work? Ensure the 
Snooze function is turned on 
and you can opt for a little extra 
nap time when the alarm goes.

 Alter the frequency
Alarms can be set as a one-off – in 
which you’d leave this section as 
‘Never’ – or they can be made to 
repeat every day, just on weekdays or 
weekends or on specific days.

 Changing the time
After creating an alarm, you can  
open the Alarm app and see the times 
you have set. Tapping the alarm lets 
you make amends such as changing  
the time.

 Label the alarm
Since you can set alarms for all kinds 
of scenarios, you are able to label them 
for clarity. Tap this button and use Siri to 
dictate the label before tapping ‘Done’.

 Knowledge base

Turning off the alarm
So the alarm is going off, you’re 
been rudely awakened and your 
brain isn’t functioning properly. 
How easy is it to turn off the 
sound now emanating from 
your Apple Watch? Very easy, 
as it happens. Just tap the side 
button to kill it stone dead or 
else press the Digital Crown if 
you fancy an extra nine minutes 
in bed.

4 Set an alarm
If you want the Watch to wake you at a certain 
time, then you will need to set the alarm. You 
start by opening the Alarms app before simply 
selecting the button ‘Add Alarm’.

5 Alter the time 
There are two numbers that you need to alter to 
set the alarm: the hour and minute. First of all, 
tap the hour and use the Digital Crown to select 
the number you want.

6 Finish off 
Now do the same for the minutes. Once you 
are happy that you have the right wake-up 
time, you can press ‘Set’. The alarm time will 
then show when you are in Nightstand mode.
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Transfer a call from 
your Apple Watch

There will be times when it makes sense to take a call on 
your Apple Watch, such as when your hands are full or if you 
are busy doing other things. The system works well and the 
Apple Watch speaker is surprisingly capable, as is the built-in 
microphone. You can hold a call in relatively noisy situations 
and still manage a conversation. However, it is more likely that 
you will want to revert to the better call quality on the iPhone if 
the call is likely to last for some time. 

The good news is that the process is completely seamless 
and requires virtually zero interaction from you which makes 
it one of the very best ‘hands off’ style features available 
anywhere in the Apple ecosystem. It is so good that the other 
party will not even know you have changed devices unless they 
happen to notice the improved sound from your end. We will 
now demonstrate just how easy the process is…

Answering calls on your Apple Watch is 
convenient, but for longer calls you may want to 
make a quick switch to your iPhone

Switch devices during a call Step-by-step

Download available

Time needed

1

Difficulty

1 Answer the call 
When a call comes in, tap the answer button 
on your Apple Watch screen and you can begin 
the conversation. It is completely up to you how 
you choose to continue the call.

2 The green bar 
Now look at your iPhone and you will see a 
green bar at the top of the screen. This signifies 
that a call is active on your Apple Watch so tap 
the bar to transfer the call. 

3 A ‘phone’ call 
The call will be automatically transferred to 
the iPhone and you can continue the call as 
normal. At no point are there any delays or 
interruptions during the switch. 

Apple Watch

 Knowledge base

Keep close
Don’t forget that your iPhone will 
need to be close to your Apple 
Watch to keep the call active on 
your Apple Watch. The call is 
actually being rooted through the 
phone via the SIM card so keep 
it within connected distance 
at all times. The Apple Watch 
without an iPhone is effectively 
just a watch.
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Activate parental controls  
in Apple TV

Apple allows you to enjoy lots of great content. You can 
watch a good film or TV show, listen to music and podcasts, 
download and launch apps, play games and make purchases. 
But some of that content isn’t suitable for everyone and there is 
also a danger that others could rack up a bill by buying media 
without your knowledge. For those reasons, Apple has included 
a raft of restrictions within the settings which you are free to 
activate and tailor. They let you age-restrict onscreen content, 
put a block on people buying things and prevent certain 
functions, all with the aim of making the Apple TV safe for all of 
the family. Just make sure the restrictions are turned on when 
your session is over – and off when you come to use it again.

Make sure children can use your Apple TV safely by restricting the content they can access

Download available

Time needed

5

 Knowledge base

Forgot your passcode?
You will need to remember 
your passcode if you wish to 
lift the restrictions for your own 
viewing pleasure. But if you 
forget your passcode, don’t 
worry. You are able to reset 
all of the settings by going to 
Settings>System>Reset. Doing 
so will restore the Apple TV to 
its factory settings, though. This 
means it will erase all settings 
and information.

Difficulty

Apple TV
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1 Enable Restrictions
To access the parental controls within Apple 
TV, you need to open the Settings app and 
navigate to General>Restrictions. By default the 
restrictions will be turned off.

2 Set a passcode
Click ‘Restrictions’ in the section marked 
Parental Controls and enter a four-digit 
passcode. You will be asked to confirm the 
passcode, which is needed to make changes.

3 Restrict iTunes
You can restrict other users from buying or 
renting content from the iTunes Store and block 
them making in-app purchases. Simply change 
these options to ‘Restrict’ and ‘Block’.

4 Alter allowed content
Go down the rest of the list, starting with Music 
and Podcasts. You can change this from 
‘Explicit’ to ‘Clean’ if you don’t want others to 
hear any bad or offensive language.

5 Select the ratings
Make sure the ratings are set for your country 
unless you want to change it – different 
countries have different rating systems. Just 
select the territory you want to use.

6 Restrict the films 
Select the option for films and choose whether 
you want to restrict all films or only those of 
a certain rating. For example, select ‘15’ and 
you’ll stop others watching 18-rated films.

7 Control TV shows
Click on TV Shows in the UK to prevent people 
viewing all programmes or just those with a 
caution attached. US viewers have a greater 
range of age-related restrictions.

8 Age-restrict apps 
Select Apps and choose an appropriate age. 
Selecting 9+, for example, means that any 
apps marked 12+ or 17+ can’t be used. You 
can also disallow all apps if you wish.

9 Block explicit words
Some books available to view on Apple TV 
contain explicit language. Likewise, Siri will 
show explicit language by default. You can turn 
these to ‘Not Explicit’ and ‘Hide’.

Turn on Apple TV’s restrictionsStep-by-step

Want to restrict children while they are playing games? You are able to 
disable multiplayer games and the making of screen recordings in games.
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There are two main methods of entering 
text on Apple TV: using the Remote to 
go back and forth among the letters of 
the onscreen keyboard or pressing the 
microphone button to dictate your words. 
Both can be cumbersome, however. You 
can often end up whizzing past a letter or 
gnashing your teeth in frustration when 
Siri fails to pick up on your pronunciation. 

The easiest way to enter text is to use 
a proper keyboard. There are two ways 
of doing this. You can pair up a Bluetooth 
keyboard – either Apple’s or a third-
party’s – or you can use the keyboard 
that is built into every iOS device. The 
latter works really well since you are 
alerted each time you encounter a text 
entry field on Apple TV, allowing you to 
tap and instantly bring up the keyboard.

Use the iOS keyboard with  
your Apple TV
The quickest and easiest way to enter words on your Apple TV is to use the 
keyboard on your iOS device

Pair the iOS keyboard with tvOS Step-by-step

Apple TV

1 Sign into iCloud
You need to be signed into iCloud. On Apple 
TV, go to Settings>Accounts>iCloud and on 
iOS go to Settings, tap your name and select 
iCloud. Input your username and password.

2 Activate Wi-Fi
Wi-Fi also needs to be enabled on both Apple 
TV and iOS. So go to Settings>Network and 
click ‘Wi-Fi’ to choose your network in tvOS 
and swipe up on iOS to ensure Wi-Fi is on.

3 Turn on Bluetooth
Bluetooth must be turned on within iOS so 
again swipe up from the Home screen of 
your iPhone, iPad or iPod touch, and tap the 
Bluetooth icon if it’s not already coloured blue.

“You are alerted each 
time there is a text entry 
field on Apple TV”

5
Time needed

Difficulty
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If you don’t want to use the iOS keyboard, go to Settings>Notifications and 
tap Apple TV Remote before moving the slider next to ‘Allow Notifications’.

4 Go to text field
Now when you use Apple TV and encounter a 
text field, your iOS device will be automatically 
notified. To activate the keyboard, tap the 
notification at the top of the screen.

5 Use the keyboard
You will see the Apple TV Keyboard screen on 
your iOS device. Enter text using the keyboard. 
You can turn the keyboard off by simply tapping 
the ‘X’ in the top-right corner.

6 See the words
As you type using the iOS keyboard, you’ll see 
the words appear on the Apple TV screen. You 
can still use the Apple TV Remote but you’ll find 
the keyboard speeds things up.

Using the iOS keyboard
Getting to grips with the iOS keyboard when 
you’re operating the Apple TV is very easy

 Knowledge base

Using a wireless 
Bluetooth keyboard
As well as using iOS, you can 
use any Bluetooth keyboard 
with your Apple TV. Make sure 
the keyboard can be discovered 
before going to the Settings 
app of Apple TV. Then navigate 
to ‘Remotes and Devices’, 
choose Bluetooth and select the 
keyboard. Enter the four-digit 
code if asked and your keyboard 
will be paired and ready for use.

 Speedy deletion
If you make a mistake, just press the 
delete key on the keyboard. You can 
also clear the text entry box entirely 
by tapping the ‘X’.

 Text entry field
Anything that you type into 
this box will appear within 
the text entry field of the 
Apple TV screen that you  
are currently on.

 Dismissing 
the keyboard
Don’t want to use the 
keyboard any more? 
Either hit the ‘X’ in 
the top-right corner 
or drag down on the 
screen to dismiss it.

 The keyboard
There is no difference between the 
keyboard used for Apple TV and the 
normal iOS keyboard. You can enter 
letters and numbers, use Siri and  
tap ‘Go’ as normal.
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Genius Bar
Our Apple devices and the software on them are some of the finest 
products on the planet, but even they have their moments. We’re here 
to give you expert advice and get you back up and running in no time

I took a rare holiday this summer and realised that I didn’t know 
how to create an auto-replay in Mail. So how do I?    Paul Heenan

AirPlay
This is a system developed 
by Apple that allows for 
wireless streaming of 
video, audio, photos and 
device screens between 
Apple devices.

Auto-Reply
This refers to a rule in the 
Mail app that you can 
toggle so that whenever 
anyone sends you an 
email, your Mail app will 
replay with an automated 
response featuring text 
that you set.

Favourites
This is a term in Safari that 
refers to the sites that you 
enjoy and visit the most 
and placing them within 
quick and easy reach from 
your browser.

Network Utility 
An Apple utility that is 
tucked away on your Mac 
that provides a variety of 
tools that can be used 
in relation to computer 
network information 
gathering and analysis. 
Use Spotlight to find it.

Setting an ‘out of office’ 
auto-reply is quick and 
easy in the Mail app

1 Go to Preferences
Start by clicking on the ‘Mail’ menu 
and then choose ‘Preferences’. 
When the Mail Preferences appear, 
click on the ‘Rules’ icon followed 
by the ‘Add Rule’ option.

2 Apply to all
Give your new rule a description, 
such as ‘Out of Office Reply’ and 
then set the first drop-down menu 
to ‘All’ and the second drop-down 
menu to ‘Every Message’.

3 Apply to all
Under ‘Perform the following 
actions’, change the first option to 
‘Reply to Message’ and then click 
on ‘Reply message text’, enter 
your auto-reply text and click ‘OK’.

The place to 
come for key 
terms made easy 
to understand 

Glossary

Facebook
iCreateMagazine

Twitter
@iCreateMagazine

Instagram
icreate_mag

Email
icreate@futurenet.com
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How do I create my own playlists in Apple Music as I can’t seem 
to fi nd any options relating to playlists anywhere? Sarah Williams

1 Go to Preferences
Click on the Safari menu and 
then choose the ‘Preferences’ 
option from the list then select the 
‘General’ tab at the top.

2 Choose Favourites
Click on the ‘New windows 
open with’ menu and choose 
‘Favourites’ and do the same 
under ‘New tabs open with’.

3 Try it out
Once done, close the Preferences 
window to save the changes and 
immediately press Cmd + N to 
open a new window and test it.

Safari has stopped displaying my favourite sites whenever I open a 
new Safari window, how can I restore them? Martin Temper

The one-stop 
column for 
Genius advice
I am thinking about 
cancelling my Apple 
Music subscription as I 
don’t really use it. Can 
you please tell me how 
I go about doing this on 
my iPhone?
Go to Settings and tap 
on your Apple ID at the 
top of the screen. Now 
tap on the ‘iTunes & App 
Store’ option and tap on 
your Apple ID at the top 
of the next screen and 
choose the ‘View Apple 
ID’ from the pop-up list 
of options that appears. 
On your Account screen, 
scroll down and you 
will see an option called 
‘Subscriptions’ – tap 
on this and all of your 
active subscriptions will 
be displayed. Tap on the 
Apple Music subscription 
and then hit the ‘Cancel 
Subscription’ button at 
the bottom of the screen.

I have started 
experiencing ghosting 
on the face of my Apple 
Watch. I have tried 
numerous things, such 
as delete, reinstall, 
reset, etc, but nothing 
seems to work. Do you 
know how to fix it? 
Try going to the Watch 
app on your iPhone and 
then go to My Watch> 
General>Accessibility 
and set the ‘Reduce 
Transparency’ option to 
‘On’ and that should help 
resolve the issue.

Apple 
Expert

You can add new Favourites to your Safari sites by clicking Bookmarks>Add 
Bookmark and then choosing ‘Favourites’ in the ‘Add this page to’ menu.

 Add songs
To add songs to your Apple 
Music playlist simply tap on the 
‘+’ icon next to a particular track 
to add them to your Library.

 Turn on iCloud Music Library
To add songs, albums and playlists to your Library you 
will need to turn on iCloud Music Library. You can either 
go to Settings>Music and turn it on or the option to turn 
it on will appear automatically in the music app when you 
start attempting to add songs.

 Download tracks
Whenever you tap on a ‘+’ 
icon in Apple Music the 
track will be downloaded to 
your Library. You can apply 
an option in Settings>Music 
to automatically download 
music added to your Library 
so you can play it offline.

This may sound like a really dumb 
question but I have just started 

using a Mac and after transferring a big 
batch of images off of my digital camera 
into the Photos app, I was wondering how 
I can go about naming them? Ken Hibbard
Simply right-click on the image in your Photos 
app and then choose the ‘Get Info’ option. 
Now, at the top of the box will be the ‘Add a 
Title’ option – just click here and then type in 
your own text. This will then be displayed when 
you double-click on the image.

 Go to Library 
When you have finished adding 
songs from Apple Music to your 
Library, tap on the ‘Library’ option 
here then tap on the menu in the 
top-left corner and choose the 
‘Playlists’ option. This will display 
any current playlists on your iPad 
but you can tap ‘New’ in the top-
right to create a new one using 
the tracks from Apple Music that 
you just added.
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The one-stop 
column for 
Genius advice
As my job involves 
sourcing online images 
I am spending a great 
deal of time clicking on 
image searches in Safari 
to see if a particular 
image is suitable. 
However, I have heard 
that there is a way to 
make the images bigger 
within Safari without 
actually clicking on 
them. How is this done?
While in Safari, click on 
the ‘Safari’ menu and 
then select the ‘Safari 
Extensions’ option. This 
will take you to a section 
full of useful extensions 
that you can install in 
Safari, one of which is 
called HoverSee (type 
this into the search field 
within this page to find 
it quicker). Click on 
‘Install now’ and a small 
icon will appear next to 
Safari’s dual URL/Search 
bar. Now, whenever 
you perform an image 
search and the results are 
displayed, click on this 
icon and then you will be 
able to hover over each 
image to view a blown-up, 
more detailed version.

My new car has CarPlay 
included – how do I set 
this up on my iPhone? 
On your iPhone, just go to 
Settings>General and you 
should see the CarPlay 
option – tap this and then 
press and hold the voice 
control button on your 
car’s steering wheel.

Apple 
Expert

When I try to connect to my Wi-Fi I sometimes get a message saying 
that the port is already being used. How can I check? Chris James

 Open Terminal
If you open your Mac’s 
Terminal app and then type in 
‘arp -a’ it will perform a quick 
scan of your network and list 
all of the devices connected 
to it so you can see what uses 
which port.

 Network Utility
The Network Utility app 
provides information and 
tools to help you with your 
network. It shows info 
about each of your network 
connections, including 
the hardware address of 
the interface and the IP 
addresses assigned to it.

 Port Scan
By clicking on the ‘Port Scan’ 
tab within the Network Utility app 
you can enter an internet or IP 
address into the appropriate field 
and then get the app to scan for 
open TCP ports…

I recently purchased an AirPlay compatible speaker, so how 
do I connect to it from my Mac? Andrew Davies

Make sure the speaker is plugged in and powered-on and then when 
it is in setup mode click on the Wi-Fi icon in your Mac’s menu bar 
and choose your speaker, which should be listed under ‘New AirPlay 
Speaker’. Check that your current network is your preferred network 
and then click ‘Next’ – you should hear an audio clue when the initial 
setup is complete – followed by ‘Done’. With your speaker set up for 
AirPlay use you will be able to connect to it any time from your Mac by 

going to System 
Preferences> 
Sound>Output 
and then 
selecting your 
speaker from 
the AirPlay 
devices at the 
bottom of the 
devices list.

I have heard that there 
is a way to adjust the 

brightness of my iPhone’s 
torch – how can I do this? 
Marcus Adams
It is possible, but you have to 
have an iPhone that supports 
3D Touch (iPhone 6s, 6s Plus, 
iPhone 7 or iPhone 7 Plus). The 
3D Touch functionality gives you 
an additional way of interacting 
with your iPhone. On supported 
models you can press the 
display to see previews, access 
useful shortcuts and more. 
To adjust the brightness of 
the touch using 3D Touch, 
simply swipe up to access your 
Control Centre and then press 
and hold on the torch icon. The 
option to adjust the brightness 
will then pop up. Simply select 
the brightness and release.

Once connected, 
you will be able 
to select your 
AirPlay speaker in 
the Sound pane

Genius Bar



81

I was given an Apple Watch as a gift 
and wondered if there are any cool 
features I should know? Taylor Ridout

I was recently using my iPad for researching a project when my nephew 
somehow closed all of my open Safari tabs, can I get them back? Neil Gibbins

1 Go to tab view
In Safari, tap on the tabs icon in the top-right 
corner of the interface. This usually displays all 
of your open Safari tabs.

2 Press and hold
Now long-press on the ‘+’ icon in the top-
right corner of the screen and a list of recently 
closed tabs will appear.

3 Re-open tabs
You can select a previously closed tab from 
the list and it will instantly be re-opened in a 
new tab at the top of your Safari window.

 Ping your iPhone
If you can’t find your iPhone in your home 
then swipe up from the bottom of the main 
screen and tap the bottom-left icon to 
make your iPhone play a sound.

 Force Touch
You can press down 
on the screen to ‘Force 
Touch’ in many of the 
apps to reveal secret 
features that aren’t 
instantly apparent.

 Check time
You can check the 
time discreetly without 
raising your wrist by 
turning the Digital 
Crown button on the 
side of the watch.

 Transfer calls
If you take a call on 
your watch but want 
to transfer it to your 
iPhone, simply tap the 
green bar at the top of 
your iPhone’s display.

When connecting your Mac to an AirPlay speaker you can also hold Alt and 
click on the speaker menu bar icon to access your speaker quicker.

We share your pain, but you’ll be glad to know that 
there is a way of restoring your recently closed tabs 
without having to strain your brain trying to remember 
the addresses of the various sites that you had visited. A 
handy feature built into the iOS 10 Safari app means that 

you can tap on the ‘+’ icon in the top-right corner to view 
all of your closed tabs. Remember that you can also open 
tabs displayed on other devices by tapping on the tabs 
icon and then scrolling down to view the open tabs on 
your Mac or iPhone.
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I have an iPhone 5C and recently it has started deleting 
picture and messages. What can I do? Claudia Cooper

1 Back up data
Go to Settings and tap on 
your Apple ID, then go to 
iCloud>iCloud Backup and 
tap on the ‘Back Up Now’ 
option to start a back up.

2 Initiate a reset
When your data has finished 
backing up to iCloud, go to 
Settings>General>Reset and 
choose ‘Erase All Content 
and Settings’.

3 Restore
Confirm by tapping ‘Erase 
iPhone’ and then, once it 
has been returned to factory 
settings, restore it from the 
backup you just made.

I enjoy using the Facebook app on my iPhone but have 
got progressively more annoyed at the amount of averts 
popping up in my feed. Can I stop them? Louise Campbell

 Go to settings
Tap on the list icon at 
the bottom and then 
scroll down and tap on 
‘Settings’. Next, tap 
‘Account Settings’ and 
then scroll down and tap 
on ‘Adverts’ to be taken to 
this screen. You can now 
begin to limit them.

 Interests
Tap on ‘Your Interests’ 
to see the many areas 
in which the adverts on 
Facebook are tailored 
to the sort of stuff you 
are into. We’re not 
sure it makes a lot 
of difference but try 
tapping on the three-
dot icons next to each 
one listed and remove 
them from the list.

 About you
Some ads you see 
are there because of 
the information you 
have shared. Tap here 
to hide info such as 
‘Employer’, ‘Job Titles’ 
and ‘Education’ from 
the advertisers.

 Hide adverts
Tap on ‘Advertisers you’ve 
interacted with’ to see all 
of the advertisers whose 
adverts you have clicked 
on and those which have 
your contact info. Now tap 
on the three-dot icon next 
to each one and you will 
be able to hide adverts 
from these particular 
companies in your feed.

I own an iPhone but often struggle 
to read the small text of the 

notifications while I am out. Is there a 
way to make this bigger? Harriet Jones
Yes, you can usually find a setting on your 
iPhone to change any aspect to suit your 
needs. To change the size of the text, 
launch your Settings app and then go to 
General>Accessibility. Now, in the second 
block of options relating to ‘Vision’ you will 
see a setting called ‘Larger Text’, which will 
be set to ‘Off’. Tap on this and then turn on 
the slider next to the ‘Larger Accessibility 
Sizes’ option. This will then enhance the size 
of the text in apps and features that support 
it to the size that you determine by adjusting 
the slider below.

I have heard that it is possible to 
use my own handwriting to 

compose text messages on my iPhone 
but I can’t find the option. Can you 
please tell me how to do it as I struggle 
with the small keyboard? Este Barker
When composing a message, after selecting 
the recipient(s), tap on the text field for your 
message and then turn your iPhone to the 
landscape orientation (pictured here). You 
should notice that a new icon appears to 
the right of the ‘return’ key – tap on this 
and a bigger text input window will appear 
into which you can write whatever you want 
using your finger or a stylus. You can also 
choose from pre-written words and phrases.

You will find options relating to text size 
in your iPhone’s Accessibility settings…
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The one-stop 
column for 
Genius advice
I use AirPod 
headphones to listen to 
music on my iPhone but 
I keep getting caught 
out by them running 
out of power. Is there 
an easy way to monitor 
their charge status?
How about using the 
Batteries widget on your 
iPhone? Swipe right from 
your iPhone’s Home 
screen then scroll to the 
bottom of the widgets 
screen and tap ‘Edit’. 
Now simply tap on the ‘+’ 
icon next to the Batteries 
widget and it will be 
added to the screen that 
is displayed when you 
swipe right. You can move 
this widget to the top of 
the screen so that you see 
it as soon as you swipe 
by pressing and holding 
on the red list icon next to 
it on the ‘Edit’ screen and 
dragging it to the top.

How can I block 
phone numbers on my 
iPhone so that I’m not 
constantly bothered by 
annoying cold callers?
Open your Phone app and 
then tap on the ‘Recents’ 
option at the bottom of 
the screen to list all of the 
numbers that have called 
you. Next, locate the 
number of the problem 
callers in the list and tap 
on the small ‘i’ icon to the 
right of it. Now it is simply 
a case of scrolling down 
and tapping on the ‘Block 
this Caller’ option.

Apple 
Expert

You can also check AirPod status quickly by fl ipping open the lid of the 
charging case with the buds inside and the charge will show on your iPhone.

I received some spoken voice MP3 fi les via Gmail and I am 
trying to transfer them to my iPod Classic. I have transferred 
them to iTunes but they don’t seem to sync, why? Tony Griffi ths

1 Connect your iPod
Connect your iPod to your Mac 
with the supplied cable and a 
small iPod icon will appear in the 
top-left corner of iTunes.

4 Select items
Find and select the MP3s that 
you wish to transfer. Remember 
you can right-click on them and 
choose ‘Get Info’ to add details.

2 Don’t sync
There is little point in attempting 
to sync as iTunes won’t recognise 
your files as playlists, artists or 
albums. All is not lost though…

5 Drag and drop
Drag the selected items across 
into the icon of your iPod as it 
appears in the sidebar and it 
should turn blue. Release to copy.

3 Enable sidebar
Click on View>Show sidebar and 
a left-hand column will be added 
to the iTunes interface that will 
display your iPod under ‘Devices’.

6 Double-check
Check that the content has 
copied by clicking on ‘Music’ 
under your iPod and scrolling 
down to the name of the file.
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Group test

2 KitSound Harlem 
Wireless Headphones

£35/$35
kitsound.co.uk

Though cheaper, KitSound’s Harlem wireless 
headphones are a far superior product to the Arenas. 

Like the SonicFuels they offer up to 30 hours of 
playback on a full charge. Plus, while still featuring 
simple playback controls in the right case, these 

don’t take the form of clunky-sounding buttons, but 
a wheel mechanism you can slide or press to skip 

tracks, play and pause. Their sound won’t blow you 
away initially, but it does improve after you run them 

in for a little while.

1 KitSound Arena 
Wireless Headphones  

£50/$50
kitsound.co.uk

Compared to the SonicFuel headphones, 
these only offer ten hours of playback on a 
full charge, but they look more aesthetically 
pleasing and deliver cracking sound quality. 

Unfortunately, they are let down by the controls 
built into the left case. When operated these 
radiate a crude, clunky sound that is audible 
above the music. If you ignore the controls 
though they sound almost as good as the 

SonicFuels at half the price.
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4 iFrogz Aurora 
Wireless Headphones

£34.99/$39.99
zagg.com

Hot off of the production line, Zagg’s new 
Aurora wireless headphones, which are part of 
its iFrogz range, are easy to power-up and pair 
and produce a nice clear sound (just don’t go 
too high with the volume or the sound starts to 
distort a little). They house two 30mm drivers 

and feature a built-in mic for phone calls. 
However, like KitSound’s Arena headphones, 

they only provide up to ten hours of battery life. 
Definitely a decent option if you are operating 

on a tight budget, though…

5 iFrogz Little  
Rockerz Costume  

£11.99/$19.99
zagg.com

If you are looking for some relatively cheap 
volume-limiting headphones for your children 

check out these fun offerings from Zagg’s 
iFrogz range. These furry tiger pattern 

headphones limit the volume to 85dB and 
also come with an audio splitter port so that a 
second set of headphones can be connected. 

Great for youngsters but the sound they 
produce is probably what you would expect 

for the price – not particularly well-defined and 
slightly tinny. 

3 Audio-Technica 
SonicFuel  

£99/$119
audio-technica.com

These wireless cans, which support aptX 
and AAC codecs, do an excellent job of 

blocking out external noise and can be used 
continuously for up to 30 hours on a full 

charge. They feature a handy set of controls 
in the left case and can also be connected 
via NFC on the iPhone 6 and above, as well 

as Bluetooth. With crystal clear mid and 
high frequencies and powerful bass being 
delivered through custom 40mm drivers, 

these sound great.



Reviews

An incredibly powerful self-contained speaker system that delivers crisp and clear audio at 
phenomenal volumes. AirPlay and Bluetooth compatibility also means you can stream 

music with the minimum amount of effort from your Mac or iOS device.

RIVA Festival  
£449/$499

Verdict

Key features Learn more Available from

The hulking centrepiece in RIVA’s ‘WAND’ range of 
multiroom speakers, the Festival is capable of filling 
a large room with up to 106dB of sound thanks to 
seven powerful ADX drivers and a proprietary six-
channel amplifier – so should the likes of Sonos and 
Denon (with its Heos range) be worried?

With three woofers, three tweeters and four passive 
radiators, the sonic-producing innards of the Festival 
are comparable to Sonos’ flagship Play:5 unit but, 
crucially, that doesn’t have the quick convenience 
of Bluetooth (in this case with a range of up to 33ft) 
to stream music from any device that doesn’t need 
to be connected to your Wi-Fi network. Of course, if 
you are installing this as your home sound system of 
choice then it is easy to connect and stream music 
from your Mac or iOS device using AirPlay. However, 

if you wish to connect multiple speakers in the WAND 
range in a homegroup then it requires two apps – 
one (Google Home) to link the speakers and set up 
the homegroup and another (RIVA WAND) to stream 
music from your device to your homegroup. This isn’t 
really a criticism as it is all easy to set up, but the 
process just isn’t as straightforward as it could be.

Sound wise, the Festival is a majestic boombox 
blasting out 200 Watts of power. It supports 
MP3, ALAC, APE, FLAC, FLAC HD, HLS, WMA 
Streaming, RTSP and PCM/WAV codecs, as well 
as high-resolution sound up to 24-bit/192kHz. It 
also delivers a 300 degree ADX Trillium sound field 
when positioned correctly. Though the simple set of 
playback controls on the top of the unit cheapens the 
look a little, this is nevertheless a premium product.

The Festival features three woofers, 

radiators in a wooden enclosure

The unit accommodates AUX and 

for charging your devices
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A far-reaching, highly effective device for filling every nook and cranny 
of your home (and garden) with glorious super-fast Wi-Fi coverage.

 And it all looks bloody marvellous as well!

Amplifi HD 
£269/$349

Verdict

Key features Learn more Available from

If your home is on the sizeable side then 
you may struggle to get sufficient Wi-Fi 
coverage in the areas furthest away from 
your router. With turbocharged 802.11ac 

Wi-Fi, this product utilises multiple self-configuring 
radios and advanced antenna technology to provide 
blanket Wi-Fi coverage throughout your home within 
a range, incredibly, of 20,000 square feet.

Set up is quick and easy – you just plug the Amplifi 
router into your existing router using the supplied 
Ethernet cable, power it up and then download the 
free Amplifi app to your iPhone to be taken through 
the process. It all takes about two minutes. Also 
included in this set are two Amplifi Mesh Points that 
you can plug into power sockets furthest away from 
the router to extend the Wi-Fi coverage. Eager to test 

these out, we positioned one near to the door leading 
out to our back garden and were able to enjoy super-
fast broadband in an outside seating area 40ft away 
for the first time ever.

The cube-shaped router itself is a great-looking 
unit with its own touchscreen interface. It measures 
approximately 10x10cm and displays a digital clock 
interface when not relaying your current connection 
speeds. The Mesh Points are slightly clunkier and 
consist of plug units with detachable, wand-like 
antennas that resemble Wii controllers. These 
antennas can be pivoted on the magnets to provide 
optimal signal coverage for your location. Certainly, 
if your home needs a Wi-Fi boost then Amplifi is 
probably the most stylish and effective system we 
have experienced. A proper box of delights.
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A stylish and attractive unit for monitoring the quality of air around your home 
and relaying the information to you through a tidy, easy-to-use app. It’s 

expensive but well worth the investment for your piece of mind. 

Foobot  
£170/$229

Verdict

Key features Learn more Available from

A product of Luxembourg-based company, Airboxlab, 
the Foobot is a device for monitoring the air quality 
around your home. By scanning your environment 
throughout the day and night and learning from your 
habits, the Foobot will provide you with warnings and 
advice to help ensure that the air around your home 
stays fresh and pollution free.

The device, which stands at around 17cm tall, 
can sit anywhere around your home and has built-in 
sensors to check for chemicals and particle matter 
that may pollute the air. The automotive-grade MOS 
sensor is sensitive to volatile organic compounds, 
formaldehyde, benzene, ammonia and methane and 
is particularly sensitive to carbon monoxide. In case 
you were wondering why this product is featured in 
an Apple magazine, it has a free accompanying app 

that you can download from the App Store. This 
app lets you set up your Foobot, connect it to your 
Wi-Fi, and then monitor your home’s air quality in 
real-time through the app’s display (which also shows 
temperature and humidity). If pollution ever goes 
above the threshold then you will receive an instant 
notification on your iPhone or iPad.

The Foobot unit itself features an attractive LED 
display that also provides a real-time heads-up to 
the quality of air in your home. All being well the 
lights stay blue, but if the quality dips below a certain 
level then the lights will flash orange. Good, clean air 
improves energy levels, helps maintain healthy sleep 
patterns and reduces the potential for respiratory 
issues, such as asthma, in children and this device/
app combo is very useful for helping maintain it.
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Premium-quality cans that deliver the finest audio money can buy.  
If you are serious about music then the enjoyment you will  

derive from these incredible headphones is infinite.

1MORE Triple Driver 
Over-Ear Headphones  

£199/$199

Verdict

Key features Learn more Available from

You can’t fail to be moved upon 
gently prizing open the packaging for 
1More’s H1707 Triple-Driver Over-Ear 
Headphones, the big beast brothers to the 

five-star In-Ear Headphones that we reviewed in issue 
175. What you take out of the box is a gorgeously 
crafted pod containing some of the hottest-sounding 
headphones we have savoured in quite some time. 

Each of the twin black and gold cans contains 
a 40mm aerospace-grade titanium driver, ceramic 
tweeter and passive radiator and they come with a 
detachable cable comprising of 99.99 oxygen-free 
copper wiring and a touch, non-tangle Kevlar sleeve. 
These headphones have also been expertly tuned 
by Grammy Award winning sound engineer, Luca 
Bignardi, so you would expect them to deliver  

high-quality, well-balanced scintillating sound, and 
they certainly don’t disappoint.

The luxurious cans clamp onto your ears and 
encase them in a fully isolated void. The look, the feel, 
even the smell of these headphones screams ‘top 
quality’ and as such we actually felt the hairs on our 
necks rippling in anticipation of hearing what sound 
they are capable of producing for the first time. And 
it seems that no amount of superlatives could really 
do them justice. Our go-to tracks for testing speakers 
and headphones revealed new sounds that we 
never thought present when listened through these, 
compelling us to delve deeper into our iTunes library 
to re-listen to tracks and albums we thought we knew 
inside out. Of course, such stunning audio comes at 
a price (200 quid to be precise), but it’s well worth it.
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If you want a big-screen, high-resolution monitor that is affordable and  
comfortable to use when working and relaxing with a good film (and  

the odd game) then this beast comes highly recommended.

BenQ Eye-Care Monitor  
£440/$570

Verdict

Key features Learn more
benq.co.uk

Available from
amazon.co.uk

At 32 inches, BenQ’s EW3270ZL Eye-Care Monitor 
is certainly one of the largest available and requires 
a considerable amount of desktop real estate to 
accommodate but, as you will soon discover, it is well 
worth making room for.

The design of the monitor won’t exactly blow you 
away – though its minimalistic base and thin bezels 
are very pleasing on the eye – but it is what it does 
in the background with quiet competency that really 
impresses. Utilising a VA (Vertical Alignment) panel, 
the EW3270ZL benefits from excellent contrast and 
black levels and incorporates Brightness Intelligence 
Technology to optimise the display performance for 
movie watching. This BI Tech detects the intensity of 
the content to ensure that the bright scenes don’t get 
overexposed while dark areas automatically adjust 

to maintain a visible level of clarity. By detecting the 
amount of ambient light in your viewing environment, 
the monitor will also make automatic adjustments to 
the brightness to help reduce eye strain and maintain 
the most comfortable viewing experience possible. 
The 3000:1 static contrast does an excellent job of 
displaying light and dark colours and overall we were 
very impressed with the image quality – especially 
when it comes to colour accuracy.

The only minor issues we had with the monitor 
were from a design point of view. The stand lacks 
adjustability in terms of height and rotation (not 
generally a problem due to the overall size) and the 
speakers are situated on the back – but, seriously, 
who doesn’t plug in their own favoured set of external 
speakers these days? 

Situated on the back of the monitor are 

which could lead to muffled sound

does lack a certain amount of 
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Accessories

Impulse Duo Dual Driver 
Wireless Headphones

£44.99/$44.99
zagg.com

These lightweight, wireless, in-ear headphones 
from Zagg’s iFrogz range are easy to pair with your 
Mac or iOS device and produce a fantastic sound 
quality that you’d struggle to get from headphones 
twice the price. They can be charged to last for up 
to ten hours and feature a neat rubber clip with a 
magnetised end to fasten them securely to your 
clothing. In the box you also get two extra sizes 

of ear tips and the charge cable, but unfortunately 
there is no case to keep them in. Great sound at a 

very affordable price. 

RIVA Arena
£225/$250

rivaaudio.co.uk
Like the mighty Festival (see page 86), the Arena forms 

part of RIVA’s range of multiroom speakers and also 
serves very well as a standalone unit for blasting out 
audio. The unit houses three ADX drivers and three 
passive radiators that produce more of the musical 

spectrum than any comparable product and you can 
connect via Wi-Fi, AirPlay, Bluetooth, DLNA and DDMS. 
An optional portable battery dock also means you can 

take the speaker anywhere. It looks and sounds stunning.

Reviews
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Fortus Gaming Mouse
£29.99/$29.99
speedlink.com

If you use your Mac for gaming then Speedlink’s 
ergonomic wireless mouse is an enticing tool to aid 

your performance. The Fortus features five perfectly-
positioned buttons, a thumb recess for strain-free 

comfort and a rubberised surface for a pleasing feel, 
as well as plenty of grip. Utilising 2.4GHz wireless 

technology for a range of up to six metres, the 
mouse also features a dpi switch that lets you adjust 

the optical sensor’s sensitivity on the fly from 600 
to 2400dpi and a non-slip scroll wheel. It looks and 

feels epic. 
 

Stikbox iPhone 7 Case
£30/$30

stikbox.com
Selfie sticks are all well and good, but who wants 

to carry one around all the time for impromptu 
photo moments? The logical step, therefore, is to 

incorporate one into the iPhone case itself, which is 
what the Stikbox is. The stick compresses neatly into 
the shell of the case when not in use and houses its 
own charge point and activation button to allow you 
to take photos on your iPhone via Bluetooth. It’s a 

great idea, but it does add significant weight to your 
device so is maybe not a permanent accompaniment 

to your iPhone.   

Pixel Stylus
£66.99/$74.99

adonit.net
Adonit are particularly proud of the Pixel, the company’s 

latest pressure-sensitive stylus for iPad, and for good 
reason. The slick tool offers unparalleled precision and 

increased tip drag for natural writing and drawing across 
all of the latest iPad models. It also boasts 2,048 levels of 
sensitivity and features programmable shortcut buttons to 

provide one-touch access to your most used features, such 
as erase and redo. With a comfortable feel and a grip sensor 

that activates the Pixel as soon as you pick it up, this is a 
must-have stylus for digital artists.   
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Magix has packed a wealth of new features into an interface that is highly  
customisable and very easy to use. The price is a little steep, however…

Sound Forge Pro Mac 3
£229/$299

Verdict

Requirements 

Learn more 
magix.com

Available from 
magix.com

Originating on the PC as a well-respected, 
comprehensive audio-editing package, Sound Forge 
has never garnered the same degree of acclaim on 
Mac. This is probably because, despite being created 
at the turn of the millennium, it didn’t actually arrive 
on Mac until 2013 – and the version that Mac owners 
did get was a distant cousin that was built from the 
ground up and lacked much of the functionality of the 
PC original. Though more features were introduced 
with version 2.0 the following year, all eyes are on 
this third iteration, recently-acquired and released 
by Magix, to deliver the complete audio recording, 
editing and processing package on Mac.

Through the app you can record high-resolution 
audio at 24 bits with sampling rates as high as 
192kHz. The user-friendly interface with customisable 
window layouts provides access to flexible hardware 
routing, adjustable metering utilities and up to 32 
channels of simultaneous recording. You simply set 

everything up, check your levels and then click the 
‘Record’ button. It’s very easy to use.

Most of the options you need in order to 
experiment with your samples can be accessed via 
the menu bar. In the ‘Process’ menu, for example, 
you can choose from a variety of fade in/out styles 
and advanced options such as élastique Timestretch 
(which allows you to time-stretch and pitch-shift 
audio while maintaining control over all stretching 
parameters) and iZotope 64-Bit SRC (which allows 
you to change the sample rate of an existing sound 
file). Plenty of processors and plug-ins have been 
bundled with the app and it also supports AU and 
VST plug-ins from third-parties, all of which are 
accessible and can be chained straight from the 
front-end of the interface to keep things simple.

Expert sound editors may feel that the features are 
still a little limited and don’t quite justify the price, but 
there is definitely solid ground here to build on.

A simple interface
You can customise the interface 
in numerous ways to create your 

perfect sound editing environment

Chain your effects
You can pick plug-ins from the 

‘Chooser’ window to the right and 
then chain them all together…  

Process your samples
The app contains plenty of options 

to manipulate your samples and 
distort the sound in exciting ways

“You simply 
set everything 
up, check your 

levels and  
then click the 

‘Record’ button”
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Very efficient at data recovery and with an additional set of Mac utility tools to die for, 
Disk Pro 3 comes highly recommended. Someone just needs to improve the interface.

Disk Drill 3 Pro
£79/$89

Verdict

Requirements 

Learn more 
508software.com

Available from 
cleverfiles.com

We’ve all experienced the pain of saving over files 
accidentally or documents mysteriously vanishing 
from our machines – and recovery options are scarce 
if you haven’t made use of your Mac’s built-in Time 
Machine software. So it’s a worthwhile investment 
to have a recovery solution on hand in times of need 
and Disk Drill 3 seems perfectly equipped to take 
on that role. The app is packed with functionality, 
such as the scope to recovery any file or folder, or 
reconstruct over 200 different types of file – and this 
extends to any connected storage device as well as 
your iOS devices.

The package also comes stacked with additional 
disk tools as well, including SMART disk monitoring 
(that constantly scans for potential disk issues), Mac 
Cleanup (which will analyse your disk space, locate 
unused files and space hogs and free up your storage 
efficiently) and Duplicate Finder (which locates and 
removes duplicate files in multiple locations on your 

drive. Then there are options to create your own 
bootable recovery drives, protect and secure your 
important data and create byte-to-byte disk and 
partition backups for future recovery. You get the 
idea, you get a considerable amount of tools for your 
outlay, many of which can be tried out for free before 
you choose to upgrade to the ‘Pro’ version. And 
certainly, we found Disk Drill to offer perfect results 
when recovering files that we recently deleted for the 
purpose of this review.

If we were to criticise this software then it would 
be for the interface. If you choose one utility, such 
as Cleanup, then the app doesn’t signpost how to 
get back to the main menu of options very well (you 
have to use a small ‘back’ arrow) and everything isn’t 
as clear or easy to find as it should be. Regardless, 
for the price, the Pro version of Disk Drill 3 presents 
great value. It’s true value, however, only becomes 
apparent when you see its recovery results first-hand.

Fast and efficient
Disk Drill is packed with features 
hat go about their task effortlessly 

in the background

Room for improvement
The only thing that lets the app 
down is the interface. It’s not as 

clean as it should be

Easy access
A Disk Drill menu bar item provides 

quick and easy access to key 
features any time

“The package 
also comes 
stacked with 

additional disk 
tools too…”

th
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An insanely solid, colourful and addictive puzzle game that brings the fun and  
magic of the long-running Bubble Bobble saga to your iOS device.

Puzzle Bobble Journey
£4.99/$4.99

Verdict

Requirements 

Learn more 
taito.com

Available from 
App Store

We here at iCreate are massive fans of Bubble 
Bobble, the classic 80s arcade game in which the 
two titular dinosaurs Bub and Bob had to rescue 
their girlfriends from fiends by blowing bubbles to 
entrap enemies and then pop them – hopefully 
simultaneously – for a massive points gain. In fact, 
at the time of going to press we are ranked 51 in 
the world leader board for the PS4 version. Puzzle 
Bobble was a popular puzzle-type spin-off that 
originated in the 90s in which gamers had to fire 
off bubbles to match groups of three in an ever-
encroaching ceiling of spheres before either clearing 
them all or experiencing a Tetris-style overload. 

This iOS release takes that concept and applies it 
to a modern progression format that takes gamers 
through a pathway of 270 levels (more are also 
available via in-app purchase). The mechanics are 
nice and solid – you simply hold your finger on the 
screen to determine the direction of your shots and 

then release to fire them off, bouncing them off walls 
if necessary to hit the desired clusters dangling 
like psychedelic haemorrhoids from the heavens. 
There are certain goals to achieve in each level 
beyond simply clearing the bubbles and you can use 
accumulated coins to purchase power-ups to make 
the tasks easier. You can also unlock extra characters 
and reap the rewards of daily prize unlocks to keep 
you coming back – but with 270 standard levels to 
enjoy plus 12 additional map-packs (at 99p a pop) to 
swell the level tally to a staggering 1,110, you don’t 
need much more incentive to be honest.

It is testament to the addictive gameplay that you’ll 
generally not stop bounding from one level to another 
for long enough to study the power-ups and their 
uses. And the game is so simple that you’ll seldom 
find the need to call on them anyway. Bonus rounds 
and boss battles flesh out the package nicely making 
this game great value for the asking price.

The gameplay is nice and simple 
– just press and hold the screen to 
direct your shots and then release 

your finger to fire them

You can also unlock, purchase and 
use characters that possess special 
skills to make conquering some of 

the hard levels easier

There are 270 standard levels to 
enjoy for the download price and 

840 more to unlock via a selection  
of in-app purchases
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